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W O W !  A p p e n d i x :  Design Tools Monthly Tips

Batch-Convert Illustrator to PDF
Here’s a trick for updating the file format of your old logos 
and other artwork to a more modern format such as PDF. 
Adobe Illustrator has a script that will batch-convert them 
for you! Just open them all in Illustrator (you can drag 
them all onto Illustrator’s icon), and then choose File> 
Scripts> SaveDocAsPDF. All the open Illustrator documents 
will be saved using your current PDF settings.

New Document, Same Size
In many Adobe applications, such as Illustrator and Pho-
toshop, you can instantly create a new document that’s the 
same size as the last new document that you created: just 
press Option-Command-N (PC: Alt-Ctrl-N). This bypasses the 
New Document dialog box, using all its previous settings 
for size, orientation and color mode.

See True Object Sizes
By default, when Illustrator displays size measurements 
for a shape, it measures from the center line of its paths, 
without taking into consideration the width of any strokes 
applied to the paths. To see the true size of a shape, includ-
ing the width of its strokes, you have to change Illustrator’s 
Preferences. Choose Illustrator> Preferences> General and 
check the Use Preview Bounds checkbox.

Adjust Handles on All Anchor Points
By default, Illustrator displays the handles for only the cur-
rently active anchor point. If you want to see the handles 
for all selected anchor points, just change the preferences: 
choose Illustrator> Preferences, highlight the Selection & 
Anchor Display area and tick the checkbox named Show 
handles when multiple anchors are selected. After that, when 
you select more than one anchor point with either the 
Group Selection tool or the Direct Selection tool, all the 
handles will be available for adjusting.

Mark Center of Artboard
In Illustrator, you can mark the center of your Artboard 
by double-clicking on the Artboard tool. In the resulting 
Options window, check the Show Center Mark option in 
the Display section, and click OK. This creates cross hairs to 
mark the center of your Artboard. If you change the size of 
your Artboard, the cross hairs will automatically re-center 
themselves.

Easier Circles
In Illustrator, if you know where a circle should begin, you 
can press the Command/Ctrl key while using the Ellipse 

tool. This lets you begin the circle’s arc exactly where 
you click, instead of at a virtual “corner” of an imaginary 
enclosing box. Use this tip when tracing a template that has 
rounded corners.

Round Corners Your Way
Instead of using the Rounded Rectangle tool, create a stan-
dard rectangle with the Rectangle tool and choose Effect> 
Stylize> Round Corners. You can then change the roundness 
at any time in the Appearance panel. As a bonus, you can 
use this effect on any shape.

Spiral Control
When using Illustrator’s Spiral Tool, you can adjust the 
tightness drop-off and loops of the spiral by using the 
Option, Command, and Up and Down arrow keys. (PC: Alt 
& Ctrl)

The Key to Aligning Objects
You can easily align a set of objects to a guide in Illustra-
tor. Using the Selection tool (V), select both the guide and 
all of the objects, then click on the guide again. The guide 
is now the “key object” with which everything will line up 
when you use the Align functions on either the Control 
panel or Align panel (Window> Align). You can do the same 
thing with any object—the key doesn’t have to be a guide.

Change the Style, But Keep the Color
Graphic styles can save any appearance attribute (color, 
effects, transforms, etc.) to re-use on other objects, and the 
new additive graphic styles lets you apply these appear-
ances without wiping out what the object looked like 
originally. Let’s say you’re drawing a set of tree ornaments 
with different Fill and Stroke colors and you want to apply 
a graphic style that has a scribble effect and a drop shadow, 
without changing the Fill and Stroke. Select all of the 
circles you’ve drawn for colored ornaments, then Option-
click (PC: Alt-click) the style in the Graphic Styles panel 
(Window> Graphic Styles) to add it while retaining all of the 
original colors.

Use Live Color to Edit Blacks
If you get an Illustrator file that you need to print but you 
find there are five different types of black, don’t fret — you 
can convert them all to a single black definition by using 
Live Color. Just press Command-A (PC: Ctrl-A) to select 
everything, and choose Edit> Edit Colors> Recolor Artwork. 
In the resulting dialog box, you can reassign the blacks.

Design Tools Monthly brings you this selection of Illustrator tips from recent issues. 

Get 3 Free Issues:
www.design-tools.com/ilwow/
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Important: Read me first!
First of all, I am really excited to bring you this twelfth 
edition of the Illustrator WOW! series. This book has been 
lovingly created for you by an amazing team of people. In 
order to provide you with the most thoroughly updated 
information in a timely manner (and as close as possible 
to the shipping of the new version of Adobe Illustrator), 
this book has become a truly collaborative project, and is 
created by a large team of international experts. 

The process begins with all of us on the team, testing 
the newest features of a pre-release version of Illustra-
tor, trying to discover which of the features is worthy 
of focus for this book by and for, artists and designers. 
Our astounding technical editor, Jean-Claude Tremblay, 
marks up the previous edition, identifying areas where we 
should be expanding and deleting. Steven Gordon and I 
co-curate the book, finding new artists and artwork that 
we think deserves inclusion. I work with each co-writer 
to determine which features they want to concentrate on, 
based on their expertise in Illustrator, and for the writers 
who are also artists, we work together to try and figure 
out which new features they might be able to incorporate 
into their professional projects. As problems arise, Jean-
Claude, Cristen, and I will often pass files and questions 
amongst ourselves, always attempting to find the most 
efficient and fool-proof workflow possible. 

With my name on the cover of the book, rest assured 
that as the book evolves, Jean-Claude and I oversee every 
single page of the book. But it’s not just the two of us—the 
entire team of writers, as well our stellar team of WOW! 
testers, actually test and critique every page as it devel-
ops. This amazing group of experts, scattered around the 
globe, come together by email, iChat, and acrobat.com, all 
working as a team in order to deliver the best book pos-
sible to you, our reader.

With the skyrocketing price of printing in full-color, 
and the fragile state of the economy, we continue to look 
for ways to keep the cover price of the book down. We 

If you’re a beginner…

Beginners are of course most 

welcome to find inspiration in 

this book. However, be aware 

that the assumed user level for 

this book is intermediate through 

professional. If you’re a beginning 

Illustrator user, please supplement 

this book with basic, beginning 

Illustrator instruction and train-

ing materials. In addition, don’t 

miss the free Illustrator training 

videos from the Adobe TV website 

http://tv.adobe.com/product/

illustrator/.

Where & what is WOW! ONLINE?

The best way to really learn 

how to make things in 

Illustrator is to examine complex 

artwork created by professional 

artists using Illustrator. You’re in 

luck! Many of the artists in this 

book have allowed us to post their 

works for you to examine and 

pick apart. Please contact the art-

ists (find their info in the Artists 

appendix) to request permissions 

beyond personal exploration. Find 

these artworks, as well as a free 

scripts from Premedia Systems, 

a year’s worth of Design Tools 
Monthly newsletters, and other 

goodies, at WOW ONLINE. See the 

Tip “Look for the WOW! ONLINE 

icon” at the top of the “How to 

use this book” section, page xvi.
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are continuing to emphasize creating art and design with 
Adobe Illustrator, and will leave the more basic and most 
technical aspects of the program to other authors and 
instructors to expand upon. To economize even more, 
instead of a DVD shipping with the book, we’ve posted 
files for you to download from WOW! ONLINE.

It’s always exciting to assemble gorgeous new examples 
of art, essential production techniques, and time-saving 
tips from Illustrator WOW! artists worldwide. Nowhere 
else can you find this combination of gorgeous, profes-
sional art, combined with the range of expertise from the 
contributing writers, and the knowledge that the WOW! 
team has thoroughly tested every lesson and gallery to 
make sure everything actually works. All lessons are 
deliberately short to allow you to squeeze in a lesson or 
two between clients, and to  encourage the use of this book 
within the confines of supervised classrooms. 

The user level for this book is “intermediate through 
professional,” so we assume that you have a reasonable 
level of competence with computer concepts (such as 
opening and saving files, launch ing applications, copying 
objects to the Clipboard, and clicking-and-dragging), and 
that you have a familiarity with most of Illustrator’s tools 
and functions. Please see the WOW! GLOSSARY appendix 
for a thorough summary of the shortcuts and conventions 
that we’ll refer to regularly in the book, as well as the sec-
tion “How to use this book…” following, for more details 
on the user level for this book.

The more experienced you become with Adobe Illus-
trator, the easier it is to assimilate all the new information 
and inspiration you’ll find in this book. I’m immensely 
proud of and grateful to everyone who works with me on 
this project. And I welcome you to the team.
Most Sincerely,

Sharon Steuer

What’s new in CS6 (and CS5)?

New features for CS6 include a 

Pattern Options panel for creating 

and editing patterns, an enhanced 

Image Trace panel (replacing 

Live Trace), gradients applied to 

Strokes, a quick-access Locate 

Object icon in the Layers panel, 

a faster Gaussian Blur, an inter-

face overhaul, and native 64-bit 

support bringing performance 

improvements across the board. 

If you missed CS5, new features 

included the Shape Builder tool, 

perspective tools, bristle brushes, 

variable width strokes with the 

Width tool, transparency in gradi-

ents and gradient mesh, and the 

Artboards panel.

How to keep in touch with us

We’ll post notes on WOW! ONLINE 

when Adobe ships mini-upgrades 

via the Adobe Creative Cloud, 

discussing how this might impact 

your workflow. We’ll also post 

announcements to WOW! ONLINE 

about future ePub versions of the 

WOW! books, Zen of the Pen™ 

courses (when they’re available), 

and CreativePro WOW! expansions. 

Communicate directly with Sharon 

via Twitter (@SharonSteuer), 

facebook.com/SharonSteuer, 

or sign up for her occasional 

eNewsletters (STEUERArtNews)_, 

or send her links to artwork, via 

http://ssteuer.com/contact.
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How to use this book…

While everyone is welcome to be inspired by the fabu-
lous work showcased in this book, please keep in mind 
that this Adobe Illustrator CS6 WOW! Book has been 
designed and tested for intermediate through profes-
sional-level users of Adobe Illustrator. That means that 
you’ll need to be familiar enough with the basics of Illus-
trator to be able to create your own art to follow along 
with the lessons. Unlike some books that do all the work 
for you, this book encourages experiential learning; as you 
follow along with the lessons, you’ll not only be mastering 
the techniques, but you’ll be creating your own art along 
the way. And to help you figure things out and inspire you 
further, this icon  tells you to look for the featured art-
work within that chapter’s folder at WOW! ONLINE (see Tip 
“Look for the WOW! ONLINE icon” at left for details). 

Shortcuts and keystrokes

Please start by looking at the WOW! Glossary in an 
appendix at the back of the book for a thorough list of 
power-user shortcuts that you’ll want to become familiar 
with. The WOW! Glossary provides definitions for the 
terms used throughout this book, always starting with 
Macintosh shortcuts first, then the Windows equivalent 
(C-Z/Ctrl-Z). Conventions covered range from simple 
general things such as the C symbol for the Mac’s Com-
mand or Apple key, and the Cut, Copy, Paste, and Undo 
shortcuts, to important Illustrator-specific conventions, 
such as C-G/Ctrl-G for grouping objects, and Paste In 
Front (C-F/Ctrl-F)/Paste In Back (C-B/Ctrl-B) to paste 
items copied to the clipboard directly in front/back of the 
selected object, and in perfect registration. Because you 
can now customize keyboard shortcuts, we’re restricting 
the keystroke references in the book to those instances 
when it’s so standard that we assume you’ll keep the 
default, or when there is no other way to achieve that 
function (such as Lock All Unselected Objects). 

Look for the WOW! ONLINE icon

When you see this icon, it 

means that you can access 

related  artwork or files for that 

project or artwork. To access a sep-

arate zip file for each chapter, plus 

a few extras, access WOW! ONLINE 

[the URL and password can be 

found here in the purchased book]. 

Where’s the Welcome screen?

Illustrator no longer starts with 

a Welcome screen, but you can 

access default (and your custom-

saved New) Document Profiles in 

the Profile list when you choose 

File> New. From this dialog you 

can also still access the Template 

menu. Use the Help menu for 

online resources, and find a list of 

recent files from the File menu. 

The default new dark interface (shown here 
with Preferences open to the new User Interface 
section to adjust this) makes screenshots more 
difficult to read in print, so throughout this book 
we’re using the Light interface setting 

The Mac and Windows WOW! Glossaries cover 
basic keyboard shortcuts for commands you’ll 
frequently use

Windows WOW! Glossary 
and essential Adobe Illustrator shortcuts

 Ctrl Ctrl always refers to the Ctrl (Control) key
 Alt Alt always refers to the Alt key

 Marquee With any Selection tool, click-drag over object(s) to select

 Toggle Menu selection acts as a switch;  
choose once turns it on, choosing again turns it off

 Contextual menu Right-click to access contextual menus  

 Group Ctrl-G to group objects together onto one layer

 Copy, Cut, Paste, Undo  Ctrl-C, Ctrl-X, Ctrl-V,  Ctrl-Z

 Select All, Deselect  Ctrl-A, Ctrl-Shift-A

  With Paste Remembers Layers on (from the Layers panel menu), pasting from 
 Paste Remembers Layers the clipboard places objects on the same layers that they were on originally;  

if you don’t have the layers, Paste Remembers Layers will make the layers for you

  Use Ctrl-F to paste objects on the clipboard directly in front of selected
 Paste in Front  objects, and in exact registration from where it was cut (if nothing is selected, 

it pastes in front of current layer with Paste Remembers Layers off)

  Use Ctrl-B to paste objects on the clipboard directly in back of selected 
 Paste in Back  objects, and in exact registration from where it was cut (if nothing is selected, 

it pastes in back of current layer with Paste Remembers Layers off)

  
 Toggle rulers on/off Ctrl-R 

 fx menu From the Appearance panel, click the fx icon to access effects 

 
 Select contiguous Hold Shift while selecting to select contiguous layers, swatches, etc.

 Select non-contiguous Hold Ctrl while selecting to select non-contiguous layers, swatches, etc.

 Toggle Smart Guides on/off Ctrl-U
 
 Turn objects into guides Ctrl-5

 Turn guides back into objects Ctrl-Alt-5 (you must select the guide first; if guides are locked, you must 
unlock them first from the contextual menu or from the View > Guides submenu)

   Find related files or artwork in that chapter's folder on WOW! Online

 Illustrator Help Access Illustrator Help from the Help menu

 260 Windows WOW! Glossary
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Setting up your panels

Illustrator initially launches with an application default 
that could inhibit the way Illustrator experts work. One 
of the most powerful features of Illustrator is that, when 
properly set, you can easily style your next object and 
choose where it will be in the stacking order by merely 
selecting a similar object. But in order for your currently 
selected object to set all the styling attributes for the next 
object you draw (including brush strokes, live effects, 
transparency, etc.), you must first disable the New Art Has 
Basic Appearance setting from the pop-up menu in the 
Appearance panel (✓ shows if it’s enabled). Your new set-
ting sticks even after you’ve quit, but needs to be reset if 
you reinstall Illustrator or trash the preferences. Through-
out the book we’ll remind you to disable it when neces-
sary, and also, at times, when it’s helpful to have it enabled. 

HOW THIS BOOK IS ORGANIZED…

You’ll find a number of different kinds of information 
woven throughout this book—all of it up-to-date for Illus-
trator CS6:  Introductions, Tips, Techniques, Galleries, 
and  References. The book progresses in difficulty both 
within each chapter, and from chapter to chapter. If you’ve 
not done this yet, please see the previous section “Impor-
tant: Read me first!” about the user level of this book.

1  Introductions. Every chapter starts with a brief, general 
introduction. In these introductions you’ll find a quick 
overview of the features referred to in the chapter Lessons 
and Galleries that follow, as well as a robust collection of 
tips and tricks that should help you get started. In fact, 
there is so much info crammed in there it’s likely that 
you’ll discover new, useful information every time you 
take a look.

2 Tips. Don’t miss the useful information organized into 
the gray and red Tip boxes throughout the book. Usually 
you’ll find them alongside related text, but if you’re in 
an impatient mood, you might just want to flip through, 

Red Tip boxes

Red Tip boxes contain warnings or 

other essential information.

Tip boxes

Look for these gray boxes to find 

Tips about Adobe Illustrator. 

If you want your currently selected object to set 
all styling attributes for the next object, disable 
New Art Has Basic Appearance by choosing it 
from the pop-up menu in the Appearance panel

Every chapter begins with an Introduction section 
that focuses on overviews of features

2

1

Everything’s under Window…

Almost every panel in Illustrator 

is accessible through the Window 

menu. If we don’t tell you where 

to find a panel, look for it in the 

Window menu!

 2 Chapter 1 Your Creative Workspace

IntroductIon

this has to stay her for the TOC
Your Creative Workspace

OK, this might not seem like sexy WOW! stuff, but to save 
time and stay focused on being creative, you need to work 
efficiently. In this chapter you’ll find tons of things you 
might have missed or overlooked. You’ll find tips for cus-
tomizing your workspace and in-depth coverage of newer 
organizational features such as working with multiple 
artboards and the multi-functional Appearance panel, 
which can take the place of several panels.

organIzIng Your Workspace

You can save time and frustration in the long run if you 
spend a few minutes setting up custom workspaces and 
creating your own document profiles. The panels you 
want handy in order to create a Bristle Brush painting 
are probably different from what you need when creat-
ing a technical illustration or the layout for a series of 
brochures. Not all panels are needed for every job, but by 
organizing all that you definitely need—eliminating all 
you’ll rarely need or won’t need at all—you’ll be able to 
locate quickly just what you need when you need it. In 
addition, the Control and Appearance panels often con-
tain the same information found in the special-purpose 
panels, permitting you to close some of those panels and 
streamline your interface even more than you might think 
possible (see the “Using the Appearance Panel” section 
later in this chapter).

In deciding which panels you want on your desktop 
for any given project, you’ll probably first want to cluster 
panels that you will frequently use in sequence, such as 
Paragraph and Character Styles or Transform and Align. 
You’ll also decide where each panel or group of panels 
should live, and whether, when you collapse them to get 
them out of your way, you want them to collapse to their 
icon and label, or all the way down to their icon. When 
you have everything arranged to your liking, choose New 
Workspace from either Window> Workspace, or from the 

tabbed docs & the app Frame

•	Change whether documents 

are tabbed (the default) or 

not through Preferences > User 

Interface. 

•	 If more documents are open 

than are visible on tabs, a dou-

ble-arrow at the tab bar’s right 

will list them.

•	Drag documents away from the 

tab to make them free-floating.

•	Drag an object from one docu-

ment into another by dragging 

over that document’s tab. The 

tab will spring open to let you 

drop the object in place.

•	On a Mac, you can also turn on 

the Application Frame (disabled 

by default) from the Window 

menu. The frame contains all 

the panels and documents, and 

everything you can do in AI 

takes place within the frame.

note: You should turn off the Ap-
plication Frame when using an 
extended monitor setup (or during 
video projection).

Magically appearing panels

If you have used Tab or Shift-Tab 

to hide your panels, mouse care-

fully over the narrow strip just be-

fore the very edge of the monitor 

where the panels were and they’ll 

reappear, then hide themselves 

again when you move away.
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looking for interesting or relevant Tips. The red arrows, 
red outlines, and red text found in Tips (and sometimes 
with artwork) have been added to emphasize or further 
explain a concept or technique. 

3 Step-by-step lessons. In these detailed sections, you’ll 
find step-by-step techniques gathered from artists and 
designers around the world. Most WOW! lessons focus 
on one aspect of how an image was created, though we’ll 
sometimes refer you to different chapters (or to a specific 
step-by-step Lesson, Tip, or Gallery where a related tech-
nique is further discussed) to give you the opportunity 
to explore a briefly covered feature more thoroughly. Feel 
free to start with almost any chapter, but be aware that 
each technique builds on those previously explained, 
so you should try to follow the techniques within each 
chapter sequentially. The later chapters include Advanced 

Technique lessons, which assume that you’ve  assimilated 
the techniques found throughout the chapter. The Master-
ing Complexity chapter is packed with lessons dedicated to 
advanced tips, tricks, and techniques, and most will inte-
grate techniques introduced in the earlier chapters. 

4 Galleries. The Gallery pages consist of images related to  
techniques demonstrated nearby. Each Gallery piece is 
 accompanied by a description of how the artist created 
that image, and may include steps showing the progres-
sion of a technique detailed elsewhere.

5 References. Within the text you’ll occasionally be 
directed to Illustrator Help for more details; to access this 
choose Help > Illustrator Help. At the back of the book, 
you’ll find a special tips supplement, plus a special list of 
Illustrator-related plug-ins, scripts, and other produc-
tion resources, both assembled for you by Design Tools 
Monthly. Next you’ll find WOW! Glossary references for 
Windows and Mac; followed by a listing the artists fea-
tured in this book, a General Index, and finally, on the last 
page, the production notes on how this book was created. 

4

5

Access Illustrator Help from the Help menu, or 
if you have function keys, use F1

 150 Chapter 5 Color Transitions

G A L L E R Y

Sebastian Murra (Mu!)

Sebastian Murra’s highly abstract, organic, often 

edgy style seems tailor-made for smartphone 

cases. He used specs from the manufacturer 

CASE-MATE to begin with a correctly sized art-

board for each device, although he only loosely 

observed the artboard size and orientation until 

the end. In fact, he made no attempt to restrain 

the art within the template, allowing it to � ow 

freely beyond the boundaries. Murra began this 

design, “Saturday Morning Cartoons,” by cre-

ating a palette inspired by the colors of fruity 

breakfast cereals for kids. He created several 

overlapping rectangles, each with a solid Fill 

and a very � ne Stroke, and used Illustrator’s 

Liquify tools, primarily Warp and Twirl, to push 

and pull the colored shapes into the swirling 

abstracts that are his signature style. He added 

contrast and depth by transforming a few black 

rectangles along with the fruit-colored ones. He 

used blending modes, especially Hard Light and 

Hue, to further integrate the swirling tangle 

of objects. He often modi� ed objects with the 

Direct Selection tool, and used Recolor Artwork 

to alter or introduce colors. Later he rotated 

everything to its � nal vertical orientation, 

then placed overlapping white rectangles on a 

layer above the artwork, which allowed him to 

experiment with different framing options until 

he found the right portion of the design that � t 

within the required size. For the � nal composi-

tion, he added a yellow-� lled background layer 

and applied a yellow tint to all the lighter col-

ors by adding another yellow-� lled rectangle, 

set to Darken blending mode, on the top layer. 

M
U

R
R

A

 212 Chapter 7 Mastering Complexity

LE
A

V
EN

S

Opacity Masking
Smooth Transitions & Intertwining Objects

Advanced Technique

Overview: Create so�  transitions 
using single-object opacity masks; 
interweave objects using complex 
multi-object opacity masks.

Chris Leavens’ fantastic realms are made plausible by the 
way objects interact with each other, creating depth and 
disguising vector edges. He o� en uses Opacity Masks to 
overlap objects believably, as well as to so� en transitions 
between shadow and full light, or between transparent 
and opaque. Instead of cutting objects apart to create 
the illusion of objects intermingling, with opacity masks 
you can keep objects intact so you can continue to make 
adjustments. Whenever complex interactions or so�  tran-
sitions are called for, Leavens � nds it easier to construct 
and work with Opacity Masks than with Clipping Masks.

1 Masking with shadows for soft transitions. In order 
to create the illusion that a critter’s head was inside the 
tendril’s tube, Leavens attached a feathered oval for the 
area of the neck that would gradually disappear into the 
gradient that creates the hole in the tendril. To do this 

The head overlapping the hollow tendril (left); 
adding an oval with a Feather effect (middle); 
shift-selecting the head <Clip Group> and oval; 
clicking on the Make Mask button (right/below)

The finished critter and tendrils (including feath-
ered ovals blending the tendrils into the pot)

1

Galleries show original art projects by artists and 
designers from around the world

3

Step-by-step lessons show you how an artist or 
designer uses a feature to tackle a creative task
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Expressive Strokes

New features in Illustrator give the user more control 
over Strokes than ever before. You can manually adjust 
the contours of a path with the Width tool to emulate cal-
ligraphy, and save its form (profile) in the Stroke panel 
to apply to another path. You can specify precisely where 
the middle section of an art brush will stretch along a 
path, and where the ends (such as arrowheads) will be 
protected from distortion. You have control over how pat-
tern brushes and dashed lines fit around corners. You can 
use “natural media” bristle brushes to make complex and 
painterly marks, emulating airbrush, pastel, and wet paint, 
and using traditional brush shapes like flat or fan. And 
symbols can be sprayed and manipulated using a special 
set of Symbolism tools.

WIDTH TOOL AND STROKE PROFILES

The Width tool (Shift-W) varies the width of strokes cre-
ated with the drawing and geometric shape tools, or art 
and pattern brushes. The path doesn’t have to be selected; 
hover over it with the Width tool and the path will high-
light, along with hollow diamonds indicating existing 
width points that were either set automatically, such as the 
end points of a path, or that you have set. As you move 
your cursor over the path, still hovering, a hollow dia-
mond moves with your cursor, ready to become a width 
point at whatever location along the path you click on. 
You can modify paths between two existing width points, 
and can create either a flowing, continuous curve, or a dis-
continuous one with a sharp break between sections. 

If width points are spaced apart, the path gradually 
gets wider or narrower from one point to the next in a 
continuous curve. If width points are placed on top of 
each other, you create a sharp break between the two 
widths, causing the curve to abruptly widen or narrow, 
much like adding an arrowhead to the path. Modify 
strokes on either side of the path either by adjusting the 

Save those width profiles

The Reset icon in the Strokes panel 

deletes all custom width profiles 

and restores the default profiles. 

To first save your width profiles, 

apply them to an object, then save 

that object’s Graphic Style in the 

Graphic Styles panel. 

Creating discontinuous curves from continuous 
curves with the Width tool when creating a flag

D
O

N
A

L 
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EY

Different Strokes

Marks made with the Blob Brush 

tool begin as a stroke, but auto-

matically turn into a filled shape. 

Find details on using it in the Re-
thinking Construction chapter. For 

the basics of applying gradients 

to strokes, see the introduction 

to the Color Transitions chapter. 

You’ll also find lessons and galler-

ies that incorporate gradients on 

strokes throughout the book.

INTRODUCTION

 This is for the TOC, leave it here
Part of this text frame MUST
be on the page for this to work!
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Width points vs. anchor points

It’s difficult to distinguish be-

tween the shape of Width points 

and normal points. The tip says 

“path” when you hover over a 

Width point, while the tip for 

other points says “anchor.”

stroke weight evenly along the path, or placing more 
weight on one side of the path than the other. Your cus-
tom stroke profile is temporarily stored in the Stroke 
panel, making it possible to apply the same stroke to as 
many paths in the document as you wish. An asterisk in 
the Appearance panel beside Stroke denotes a width pro-
file. You can also save a custom profile as part of a Graphic 
Style and/or to the Profiles list using the Save icon at the 
bottom of the Stroke panel list. The Reset icon restores 
the default width profiles, replacing any custom profiles 
you’ve saved, so be careful about choosing to restore the 
default width profiles. You can modify width points in a 
variety of ways with the Width tool:

•	To open the Width Point Edit dialog, double-click on 
a path or existing width point. Numerically input the 
stroke weight for each side of the path, and/or choose to 
have adjoining width points adjusted at the same time.

•	To interactively adjust the width point, click-drag on 
a handle to symmetrically adjust the stroke width.

•	To adjust one side of a stroke, press Option/Alt while 
dragging on a handle.

•	To adjust or move multiple width points, Shift-click to 
select the points (not anchors) you want to alter, then drag 
on one point or handle to adjust the others with it. 

•	To adjust or move all adjoining width points (up to 
the next corner anchor point), hold Shift while dragging.

•	To copy selected points, hold Option/Alt as you drag.
•	To delete a selected width point, press the Delete key.
•	To deselect a width point, click on an empty space away 

from the path, or press the Esc key.

THE EXPANDED STROKE PANEL

The Stroke panel controls settings for the many different 
types of strokes, from how they align to the path of an 
object to how they join at corners. Dashed lines, end caps, 
and arrowheads all are part of the Stroke panel, as well 
as stored width profiles, from a normal even width to a 
fully calligraphic profile. Here you can also customize and 
save your carefully crafted stroke profiles after creating a 

(Top) The starting stroke with width points al-
ready added and adjusted; (middle) the width 
point at the right end adjusted again to make 
the end wider and Adjust Adjoining Width Points 
disabled; (bottom) with Adjust Adjoining Width 
Points enabled when adjusting the same original 
right-end width point—starting stroke shown for 
clarity in red on top of both adjusted strokes

Shift-selecting just some contiguous (shown) or 
non-contiguous (not shown) width points on a 
pattern brushstroke, releasing Shift, then moving 
them all at once 

To numerically adjust one or more selected width 
points, double-click on one to open the dialog 
and make adjustments; select just one point 
before entering the dialog if you want to enable 
Adjust Adjoining Width Points
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variable-width stroke, and preview how your path joins to 
an arrowhead. Adjust the way dashes follow a path, and 
scale arrowheads to suit.

Making ends meet

Sometimes stroked lines seem to match up perfectly when 
viewed in Outline mode, but they visibly overlap in Pre-
view mode. You can solve this problem by selecting one of 
the three end cap styles in the Strokes panel. The default 
Butt cap causes your path to stop at the end anchor point 
and is essential for creating exact placement of one path 
against another. The Round cap is especially good for 
softening the effect of single line segments. The Project-
ing cap extends lines and dashes at half the stroke weight 
beyond the end anchor point. Cap styles also affect the 
shape of dashed lines.

Corners have joins that serve a similar purpose to 
end caps. The Join style in the Stroke panel determines 
the shape of a stroke at its corner points; the inside of the 
corner is always angled. The default Miter join creates a 
pointy corner, with the length of the point determined by 
the width of the stroke, the angle of the corner (narrow 
angles create longer points), and the Miter limit setting on 
the Stroke panel. The default Miter join (with a miter limit 
of 10x) usually looks fine, but can range from 1x (which is 
always blunt) to 500x. The Round join creates a rounded 
outside corner with a radius of half the stroke width. The 
Bevel join creates a squared-off outside corner, equivalent 
to a Miter join with the miter limit set to 1x.

Dashes behave like short lines, and therefore have 
both end caps and, potentially, corner joins. End caps 
work with dashes exactly as they do with the ends of 
paths—each dash is treated as a very short path. However, 
if a dashed path goes around the corner, it can make that 
turn in one of two ways: The spacing between the dashes 
can be precise and constant, so the dash won’t necessarily 
bend around a corner, or even reach to it, or you can click 
the “Aligns dashes to corners and path ends, adjusting 
lengths to fit” icon. Dashes won’t be precisely spaced, but 

With the Stroke panel width profiles list, save or 
delete one custom width profile at a time (reset-
ting defaults removes all custom width profiles)

(Top) When Dashes with round caps are added 
to art by Sally Cox, the default option in the 
Stroke panel preserves dash size but are unevenly 
distributed around the frame; (bottom) changing 
the option to Align to corners dash size varies 
the size of dashes but evens spacing

SA
LL

Y
 C

O
X

A path shown first in Outline, then in Preview 
with a Miter join, Round join, and Bevel join
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will look tidy at the corners. The command affects dash 
spacing for other shapes, from circles to stars, as well.

One more “end” to a path is an arrowhead, and the 
Stroke panel now offers a choice of both the types of 
arrowheads and how they are affixed to the ends of the 
paths. Click on the Arrowheads pop-up list to choose to 
attach an arrow or feather to the start or end of the path. 
You can then scale it proportionally or disproportionally, 
reverse the start and end, or align the arrowhead so that 
either the tip or the end of the arrow meets the end of the 
path. To remove an arrowhead (or feather), choose None 
from the list. You can add custom arrowheads to the list 
without removing any of the default arrowheads (you’d 
have to reinstall Illustrator to make them available again 
if you removed them). Both dash alignment options and 
arrowheads can be modified again at any time. 

BRUSHES

Illustrator’s calligraphic, art, scatter, bristle, and pattern 
brushes can mimic traditional art tools, create photoreal-
istic imagery, or provide pattern and texture to your art. 
You can either create brushstrokes with the Paintbrush 
tool, or you can apply a brush to a previously drawn path.

Calligraphic brushes create strokes that mimic real-
world calligraphy pens, brushes, or felt pens. You can 
define a degree of variation for the size, roundness, and 
angle of each “nib.” You can also set each of these attri-
butes to respond to a graphics tablet and stylus (like the 
Wacom) with a variety of different pen characteristics 
(with a mouse, you can only use Fixed or Random).

Art brushes consist of one or more pieces of artwork 
that get fitted to the path you create with them. You can 
use art brushes to imitate traditional painting media, such 
as drippy ink pens, textured charcoal, spatter brushes, dry 
brushes, watercolors, and more. Or an art brush can rep-
resent real-world objects, such as a petal, a leaf, or a rib-
bon, a flower, decorative flourish, or train. You can modify 
art brushes and their strokes using a number of different 
parameters, including variables affected by pressure using 

Creating custom arrowheads

Illustrator Help provides directions 

for locating the Arrowheads file 

on your computer. The file con-

tains instructions for customizing 

and saving arrowheads without 

overwriting the original file.

Using the Arrowheads section of the Stroke 
panel to align the arrowhead so the tail of the ar-
rowhead joins the end of the path with the head 
extending beyond (left and as shown in the dia-
log), or to align the arrowhead so the tip of the 
arrowhead joins the end of the path (right)

Graphics tablets & brushes

Bristle brushes, which mimic paint-

er’s brushes, respond to hand ges-

tures when using a tablet and pen, 

such as the Wacom. The “Wacom 

6D Art” or “Art” pens also easily 

retain the appearance of the indi-

vidual bristles, while allowing full 

rotation to create unique strokes 

that imitate real brushes. A mouse 

is much more limited.

Deleting arrowhead presets

To make custom arrowheads, be 

sure to modify only the file hold-

ing the default presets. If you 

delete any arrowheads in that file, 

you’ll have to reinstall Illustrator 

to get them back again. 
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a Wacom tablet and stylus). Art brush marks can be made 
to scale proportionately to fit the length of your path, 
or stretched to fit. You can also scale your brush non-
proportionally by restricting the area of the art brush that 
can stretch, using two guides to create a segmented brush 
(choose Stretch Between Guides for the Scale option). 
Either or both ends of the brush are then protected from 
being stretched, and the middle portion is stretched to 
fill in the remaining length. This allows you to stretch 
the stem of a rose, for instance, without stretching the 
blossom itself. You can further modify an art brush with 
colorization methods, such as choosing to vary a key color 
by tint or hue. Modify the way the art brush follows a 
path by flipping its direction, and use the Overlap option 
to determine whether or not to allow it to overlap itself 
when turning a corner. You can also use the Width tool to 
modify an art brush.

Use scatter brushes to scatter copies of artwork along 
the path you create with them: flowers in a field, bees in 
the air, stars in the sky. The size of the objects, their spac-
ing, how far they scatter from the path, and their rotation 
can be set to a Fixed or Random amount or, with a graph-
ics tablet, can vary according to characteristics such as 
pressure or tilt. You can also align the rotation of the scat-
tered objects to the direction of the path, or to the edges 
of the page. Change the method of colorization as you 
would with a calligraphic or pattern brush.

Use pattern brushes to paint patterns along a path. To 
use a pattern brush, first define the tiles that will make up 
your pattern. For example, a train has an engine, rail cars, 
links, and a caboose. Each of these constitutes a tile where 
you have the start of the path, the middle (the side tile), 
the tiles that turn either an inside or outside corner, and 
the end of the path. The tiles must be made as individual 
art and stored in the Swatches panel before you can make 
your pattern brush. Afterwards, however, you can delete 
them from Swatches. In the Pattern Brush Options dialog, 
select a tile, then click on the swatch name below the tiles 
that you want assigned to that tile. You can customize 

The Scatter Brush dialog varies how the artwork 
is scattered along a path

Using the Width tool to alter an Art brushstroke 
modified by Stretch Between Guides option

Altering Pattern Scale and Spacing to create a 
very different look to the brush
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settings for how the tiles fit to, or flip along, the path, and 
to alter their color. You can also vary the appearance of 
the pattern brush, how it fills sharp angles (by altering the 
Scale in both Fixed parameters and those affected by tab-
let features), and the spacing between tiles. 

Bristle brushes emulate traditional paint brushes, 
showing both the texture of the bristles and the tip 
shape, which can be round, flat, fan-shaped, etc. To cre-
ate a bristle brush, select it as the New brush type and, 
in the Bristle Brush Options dialog, choose a tip shape. 
From there, modify the brush’s bristle length, density, 
and thickness; whether or not the bristles are stiff or soft; 
and how opaquely it applies the paint. By default, these 
brushes use a Paint Opacity of less than 100%, so you’ll 
see some opacity in your strokes even when you have set 
Opacity in the Control panel to 100% opaque. Because 
calculating transparency for printing often takes a long 
time, a dialog warns that if you have more than 30 bristle 
brushstrokes, you may want to select some or all of the 
bristle brushstrokes and choose Object> Rasterize to set 
raster settings for them before you attempt to print. 

Working with brushes

The following describes functional features that apply to 
most or all brushes:

•	To create art, scatter, and pattern brushes, create the 
artwork for them from fairly basic artwork, including 
compound shapes, blends, groups, and some live effects 
such as Distort & Transform or Warp. You can’t create 
brushes from art that uses gradients, mesh objects, raster 
art, and advanced live effects such as Drop Shadow or 3D.

•	To modify the art that makes up a brush, drag it out 
of the Brushes panel, edit the object, then drag it back into 
the Brushes panel. Use the Option/Alt key as you drag to 
replace the original art with the new art. 

•	To set application-level preferences for all brushes, 
double-click the Paintbrush tool. (The new preferences 
will apply to work you do with the brushes going forward, 
but won’t change existing work.) 

Draw inside and bristle brushes

Bristle brushes are a good candi-

date for the Draw Inside mode 

(see the Rethinking Construction 

chapter). You can add the bristle 

texture to a vector shape while re-

taining some or all of the original 

color; Draw Inside also constrains 

the strokes inside the object, en-

suring stray bristle marks are auto-

matically masked.

Symbols vs. scatter brushes

Because it’s easy to edit symbols, 

using symbols can be preferable to 

using scatter brushes, whose attri-

butes will be applied to the whole 

set. The ability to delete individual 

symbols within a set is another 

potential advantage over scatter-

ing objects with a brushstroke, 

which must be expanded before 

individual objects can be deleted 

from it.

Using a bristle brush (the Footprint brush show-
ing) to draw inside a selected path, and the Lay-
ers panel showing the Clipping Paths created by 
Draw Inside
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•	To modify the properties of a single brushstroke, 
select it, then choose Options of Selected Object in the 
Brush panel’s menu. If you’ve used the Width tool to mod-
ify the stroke, your options include using the width points 
to calculate the profile for your next strokes.

•	To choose how to apply modifications to existing 
brushstrokes, in the brush’s Options dialog choose Leave 
Strokes to create a duplicate brush, or Apply to Strokes to 
modify every use of the brush in the document.

•	When Keep Selected and Edit Selected Paths are both 

enabled, the last drawn path stays selected; drawing a 
new path close to the selected path will redraw that path. 
Disabling either of these options will allow you to draw 
multiple brushstrokes near each other, instead of redraw-
ing the last drawn path. 

SYMBOLS 
Working with symbols in Illustrator saves file size (since 
objects converted to symbols aren’t duplicated in the file), 
provides consistency whenever the same artwork needs 
to be used more than once, and makes it easy to update 
objects in your artwork simply by editing the symbol to 
change it wherever it has been used. Symbols can be made 
from almost any art you create in Illustrator. The only 
exceptions are a few kinds of complex groups, such as 
groups of graphs, and placed art (which must be embed-
ded, not linked). Symbols are edited and stored using the 
Symbols and Control panels, and are manipulated like 
other objects, or with the Symbolism tools:

•	To store selected artwork as a symbol, drag it into the 
Symbols panel (or click on the New Symbol icon in the 
panel). Use the Libraries Menu icon to save the current 
symbols to a new library, or to load other libraries.

•	To add a single instance of a symbol to your docu-

ment, drag it into your document or, with it selected, 
click on the Place Symbol Instance icon. Drag a symbol 
instance into your document as often as you like, but you 
can only use the Place Symbol Instance icon once. It’s 
most useful for modifying the symbol (see following).

Modifying based on Width Points using Options 
of Selected Object for an Art Brush that has al-
ready been modified with the Width tool

Symbolism Tools Options dialog

Quick access to Symbol features on the Control 
panel when a symbol object is selected in the 
artwork; the Reset button not grayed out indi-
cates the symbol has been transformed and the 
Replace pop-up gives immediate access to the 
loaded Symbols library

Bristle brush opacity

Set bristle brush opacity:

•	 In bristle brush Options under 

Paint Opacity.

•	With the Paintbrush tool active, 

the 1-0 keys change the opacity 

for selected strokes, or, with no 

strokes selected, the setting af-

fects the next brushstroke.

•	With the Opacity slider in the 

Appearance or Control panels.
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•	To modify a symbol without modifying the original 

symbol in the Symbols panel, click either the Break 
Link button in the Control panel or the “Break Link to 
Symbol” icon in the Symbols panel. 

•	To modify a symbol and all instances of it already 
in the document, place or drag it into your docu-
ment, then click on the Edit Symbol button in the 
Control panel. Your symbol will be placed in isolation 
mode. After you modify it and exit isolation mode, all 
instances of the symbol, including the symbol in the 
Symbols panel, are updated.

•	To modify a symbol in the Symbols panel when you 

have already broken the link, Option/Alt-drag the 
modified symbol on top of the symbol in the Symbols 
panel. This will replace the original symbol with the 
modified artwork and update all instances of the origi-
nal symbol.

•	To restore a symbol to its original size and orienta-

tion after transforming it, click the Reset button in the 
Control panel.

•	To quickly find all instances of a symbol in your 
artwork, select the symbol either in the Symbols panel 
or in your artwork and choose Select All Instances from 
the Symbol panel’s menu.

•	To replace one symbol with another without open-

ing the Symbols panel, select the symbol in the art-
work and click on the Replace list arrow in the Control 
panel. A miniature Symbols panel opens, which allows 
you to swap out symbols.

•	To add a sublayer to a symbol’s artwork, in isola-
tion mode click on the topmost layer with the symbol’s 
name, and then click on the New Sublayer icon. (You 
can’t add sublayers to a <Group> or <path>.)

•	To add a new layer above a group or path sublayer 

at the same hierarchy level, target the layer, then 
Option-click/Alt-click on the New Layer icon. If the 
layer remains a normal layer (not a group or a path), 
you can continue to add new layers at that level merely 
by clicking on the New Layer icon.

Transforming symbols

When creating symbols, Illustrator 

has two features that are impor-

tant whenever a symbol might be 

scaled or transformed any other 

way: If you use Flash, these fea-

tures also affect symbols taken 

into Flash for animating:

•	Apply 9-slice scaling to symbols 

in Illustrator. Doing so reduces 

distortion when transforming 

objects, especially noticeable 

with elements such as buttons 

that have custom corners. All 

nine areas of the symbol can be 

scaled independently.

•	Assign a Registration point to 

the symbol in Illustrator. The 

point appears as a crosshair 

both in Symbol Edit Mode and 

when the symbol is selected 

in normal mode. Use the Reg-

istration point to affect any 

transformations applied inside 

Illustrator.

Storing symbols in the Symbols panel, with ac-
cess to other symbol libraries, editing commands, 
and the Symbol Options dialog
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Working with the Symbolism tools

There are eight different Symbolism tools. Use the Symbol 
Sprayer tool to spray selected symbols onto your docu-
ment, creating a symbol set. You can’t select individual 
instances inside a set with any of the selection tools. 
Instead, modify them with any of the other Symbol tools. 
To display a ring of tools in your document in order to 
select a new one, press Control-Option/Ctrl-Alt while 
clicking and holding in an empty spot in your document, 
then drag to a new icon before releasing your mouse. (In 
the CS6 1.0 release, the HUD doesn’t appear, but you can 
still see the Symbolism icons for the tools change in the 
Tools panel.) Add symbols to a selected set by selecting 
a symbol in the Symbols panel—the symbol can be the 
same as or different from the symbols already present in 
the instance set—and spray. To add or modify symbols in 
a set, make sure you’ve selected both the set and the cor-
responding symbol(s) in the Symbols panel that you want 
to affect. The Symbolism tools will only affect those sym-
bols in a selected set that are also selected in the Symbols 
panel, thus making it easy to modify just one of the sym-
bols in a mixed set.

To adjust the properties of the Symbolism tools, 
double-click on one to open Symbolism Tools Options. 
Vary the diameter (the range over which the tool oper-
ates), the rate at which it applies a change, and the density 
with which it operates on a set. If you’re using the default 
Average mode, your new symbol instances can inherit 
attributes (size, rotation, transparency, style) from nearby 
symbols in the same instance set. For example, if nearby 
symbols are 50% opaque, symbols added to the set will 
also be 50% opaque. You can also change the default Aver-
age mode to User Defined or Random. (See Illustrator 
Help for more information about choosing User Defined.)

To remove symbols from an existing instance set, use 
the Symbol Sprayer tool with the Option/Alt key, and 
click on an instance to delete it (or click-drag your cur-
sor over multiple instances—they’re deleted when you lift 
your cursor).

Adding a new layer at the same level as a path 
sublayer by Option-clicking/Alt-clicking on the 
Create New Layer icon

Using the Symbolism tools to modify the original 
set (top) for greater variety (bottom)

Artwork by Lisa Jackmore created with symbols
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G A L L E R Y

Donal Jolley

This sampler by Donal Jolley, using his 6D Art 

Pen, demonstrates the tremendous variety 

you get from brushes that ship with Illustrator. 

When you add a Wacom pressure-sensitive pen 

and tablet to these out-of-the-box brushes, 

you can introduce even more variety into your 

strokes; the standard Grip Pen registers pres-

sure, tilt, and bearing, and the optional, more 

sensitive Art Pens (6D Art for Intuos3, or Art 

Pen for Intuos4) add the ability to vary each 

stroke with rotation. The bristle brush responds 

particularly well to the Art Pens, adding a new 

dimension to painting. You can manually trans-

form some of your strokes (but not those made 

with the calligraphic, scatter, or bristle brushes), 

by modifying its profile with the Width tool 

(such as Spikey above), and then saving that 

profile to apply to other strokes.

JOLLEY
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1

2

The original sketch

Traced sketch

Width tool (Shift-W) adjusting middle of stroke

PUTNAM

Ryan Putnam creates many character illustrations for 
websites, branding projects, and more. Putnam now uses 
the Width tool to add depth and variance in the strokes of 
the illustrations. Moreover, he can save the stroke adjust-
ments to Profiles in the Stroke panel to easily apply to 
other strokes in current and future projects. 

1 Placing a sketch template and tracing with Pen tool. 

Putnam first created a character sketch in Photoshop, 
chose File> Place in Illustrator, enabled Template, and 
clicked OK. Putnam then traced basic paths of the sketch 
with the Pen tool in the layer above.

2 Adjusting strokes with the Width tool. Putnam 
wanted his strokes to have some variance compared to the 
uniform strokes created by the Pen tool. He created two 
distinct stroke widths to use on the majority of the paths 
in the illustration. For the first stroke adjustment, Put-
nam created a stroke with a thicker middle and tapered 
ends. To do this, he used the Width tool to click in the 
middle of the desired path and drag a width point to the 

Stroke Variance
Creating Dynamic Variable-Width Strokes

Overview: Place sketch and trace 
with Pen tool; modify strokes with 
Width tool; save width profile and 
apply to other strokes. 
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desired width. For the second custom width, Putnam cre-
ated a stroke with a thicker end and a tapered end. Again, 
he used the Width tool, but this time clicked on the far 
right side of the desired path and dragged a width point 
to the desired width.

If you like to be precise with your adjustments, you 
can double-click a width point to open the Width Point 
Edit dialog, allowing you to numerically adjust the width 
of the stroke in the Side 1, Side 2, and Total Width fields.

3 Saving stroke profiles and applying to other paths. 

Instead of adjusting every path in the illustration to 
match the two custom widths he created with the Width 
tool, Putnam saved time and ensured consistency by sav-
ing his two custom stroke profiles. To save each profile, 
he selected the modified stroke and clicked the Add to 
Profiles icon in the Stroke panel. With both of his strokes 
saved as custom profiles, Putnam could select a uniform 
stroke, click the saved Variable Width Profile at the bot-
tom of the Stroke panel, and select the saved profile from 
the drop-down list. These custom profiles will then be 
available in other new Illustrator files.

After Putnam applied the custom profile to all the 
desired paths, he utilized specific keyboard commands 
with the Width tool to further adjust individual paths. 
For example, holding down the Option/Alt key when 
dragging width points creates non-uniform widths, the 
Delete key deletes selected width points, and holding the 
Shift key while dragging adjusts multiple width points. 
Other keyboard modifiers with the Width tool include 
holding down Option/Alt while dragging a width point 
to copy the width point, holding down Option-Shift/
Alt-Shift while dragging to copy and move all the points 
along a path, Shift-clicking to select multiple width 
points, and using the Esc key to deselect a width point. 

4 Applying finishing touches. Putnam added additional 
elements as needed. For instance, he create simple shapes 
with the Pen tool and filled them with grayscale colors.

3

Saving new width profile

Applying a saved width profile

Adjusting a path with Width tool and keyboard 
commands

4

Width tool (Shift-W) adjusting end of stroke
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G A L L E R Y

MCKIBILLO (AKA Josh McKible) 

For a commissioned piece on different manage-

ment styles, MCKIBILLO used the parable of 

the Blind Men and the Elephant as the basis 

for his illustration. He began with a sketch cre-

ated in Alias SketchBook Pro that he traced in 

Illustrator using the Pen tool. While the image 

was in progress, he used a fine, uniform line, 

bright Magenta so it wouldn’t visually disap-

pear. When it came to finessing his linework, 

MCKIBILLO frequently applied a couple of the 

default width profiles from the Profile pop-

up in the the Stroke Panel to create many of 

the lines. If he needed even more control over 

the shape of his strokes, however, he used the 

Width tool to modify both width and anchor 

placement along a curve. In this illustration, 

he manually delineated the hands and finger-

nails with the Width tool. Most of his strokes 

used a rounded cap, but he occasionally varied 

the cap according to the way the lines joined. 

Using the Width tool, and then saving and reus-

ing profiles (from Profile in the Stroke panel), 

MCKIBILLO was able to quickly develop a style 

that appears completely hand-drawn, yet 

has the advantage of remaining easily edited 

throughout the course of a project.
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G A L L E R Y

Donal Jolley

To create his “Rubber Ducky,” Donal Jolley 

began by drawing the basic lines with the Pen-

cil tool. Then with the Width tool, he adjusted 

each stroke so it curved gently and came to a 

sharp angle at the end (his custom profiles are 

shown above). To finalize the line work, he 

used the Scissors and Eraser tools to clean up 

the extra anchor points that sometimes occur 

at the end of brushstrokes. He then locked his 

line work layer and created a new layer at the 

bottom, into which he painted the colors. He 

works very intuitively with the brushes, saying, 

“Usually I will open a brush category, choose 

JOLLEY

a brush, and then make a stroke with a sharp 

angle and a gentle curve to see how it behaves 

with the color I want to use. Because many of 

the strokes have a certain transparent qual-

ity that does not truly mix with the underly-

ing color (or white), I make sure of the stroke 

before I employ it. I check for opacity, form, 

and how it ‘bends,’ because many brushes 

tend to give unpredictable results at sharper 

angles.” Then, using his chosen default bristle 

and calligraphic brushes, Jolley painted the 

ducky’s colors, varying pressure and angles 

with his Wacom Intuos tablet and 6D Art Pen.
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G A L L E R Y

Lisa Jackmore

For drawings as fluid as this floral design, Lisa 

Jackmore finds that initially drawing with the 

Paintbrush tool and a calligraphic brush is 

the most natural and intuitive way to begin. 

However, when she wants to create specific 

variations to the strokes, she then converts the 

brushstrokes to Basic stroked paths, so she can 

use the Width tool (you can’t use the Width 

tool on calligraphic brushstrokes). To do this, 

she clicked on the Basic Brush in the Brushes 

panel (the basic stroke version is shown directly 

above). Jackmore then selected the Width tool 

(Shift-W) and clicked on the stroke itself, drag-

ging the handle outwards to evenly widen the 

path. To make adjustments to one side, she held 

the Option/Alt key while dragging the handle. 

To make even further variations to the strokes, 

Jackmore clicked on the stroke, added new 

width points, and adjusted them. She saved 

several profiles by selecting each modified 

stroke, then from the Variable Width Profile 

menu in the Control panel, clicking on the 

Add to Profile button, naming it, and clicking 

OK. To finish the design, she selected each 

of the remaining paths, applied one of her 

saved width profiles from the Control panel, 

and then increased the stroke weight on all of 

the paths. Jackmore’s background includes a 

gradient mesh object and a few bristle brush-

strokes drawn with the Paintbrush tool.

JACKMORE
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G A L L E R Y

Ann Paidrick 

For Ann Paidrick, the Width tool was 

key to creating the hand-drawn look 

for this pair of spiral patterns. Start-

ing with the Spiral tool (hidden under the Line 

tool), she used the up and down arrow keys 

to vary the wind of each spiral as she drew. To 

begin with she chose an orange fill and black 

stroke. Clicking Stroke in the Control panel, 

she chose the Round Cap, and for each spiral 

she set a stroke weight between 5 and 8 pts. 

Next she used the Width tool on each spiral to 

thicken some areas while narrowing others. For 

final tweaks to the paths, she used the Direct 

Selection tool to move anchor points 

and direction lines just enough to cre-

ate a hand-drawn feel. After assembling a cluster 

of spirals together, she entered Pattern Edit Mode 

(PEM), where she finished arranging the elements 

until the pattern worked as a whole. After sav-

ing the orange and black pattern, she remained 

in PEM, where she created and then saved the 

version at top by changing spiral fill and stroke 

colors, and putting a rectangle with a purple fill 

beneath the spirals (for more about using PEM 

see the Mastering Complexity chapter).
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G A L L E R Y

Lisa Jackmore

To make interesting brushstrokes, Lisa Jackmore 

used variations of a few calligraphic and bristle 

brushes, painted using a Wacom Intuos4 tablet 

and Art Pen. In creating the variations for the 

brushes, Jackmore changed the parameters for 

Pressure, Rotation, and Tilt. When she wanted 

to customize a brush, she double-clicked the 

brush, and made changes to the options. For 

the tree outline, she used a 3-pt Flat calligraphic 

brush, set the Diameter to Pressure (with a 

2-pt variation), Roundness to Tilt (34°, with a 

variation of 15°), and set the Angle to Rotation 

(with a 125° variation). For the long sweeping 

lines of the tree, she found the combination of 

using Rotation and a chisel tip of the Art Pen 

worked the best to vary the brushstroke. As she 

drew, she slightly rotated and tilted the pen 

and created variations in her stroke. To create 

an irregular ink-like appearance in the words, 

she used a 1-pt Round calligraphic brush, and 

set the Angle to 30° (fixed), Roundness to Tilt 

(60°, with a 29% variation). Jackmore used 

several other variations of calligraphic brushes 

to draw the suitcases and background pattern. 

To make the pattern, she drew several paths 

with a customized calligraphic brush, grouped 

the brushstrokes, and dragged the pattern tile 

to the Swatches panel. After she drew all of 

the black brushstrokes, she colored the illustra-

tion with a gradient mesh object for the back-

ground, and used variations of the Fan, Round 

Blunt, and Round Point bristle brushes for other 

areas, such as the bird, suitcases, and shadows. 

Finally, Jackmore used the rectangle tool to 

make a frame, then applied a Charcoal brush to 

the stroke.

JACKMORE
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G A L L E R Y

Anil Ahuja/Adobe Systems 

Adobe’s Product Specialist Anil Ahuja used a 

range of tools and techniques to create his 

dragonfly, and relied upon transparency meth-

ods to obtain color accuracy to closely match his 

reference photo. In his three levels of objects 

used to create the wings (shown separately at 

right), this is readily apparent. After drawing 

the wing’s black-stroked vein structure with 

artistic calligraphic brushes of various sizes 

and shapes, he selected the paths and chose 

Object> Expand (to outline the strokes), then 

Merge (to create a compound path object). 

In the Appearance panel he clicked Opacity, 

and changed the Blending Mode to Darken to 

reduce the opacity, giving the wing its realistic 

brown color. With the brown and blue gradient 

mesh objects (residing on a layer beneath the 

vein structure), Ahuja used the Direct Selection 

tool to select individual mesh points to decrease 

the opacity (ranging from 0–90%). To make 

the wings appear translucent instead of just 

transparent, Ahuja used the Pen tool to draw 

an outline copy of the wings which he put on a 

layer below the veined structure and the mesh. 

He filled the outline with a color similar to the 

background and reduced the opacity to 30%. 

To complete the illustration, Ahuja created a 

shadow on a layer between the dragonfly and 

the gradient mesh background. To make the 

shadow, he pasted a copy of the wing outline 

and with the Pen tool added an outline of 

the body. He then reduced the opacity of the 

shadow object to 53% and changed the Blend-

ing Mode to Darken.

AHUJA
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STEUER

Brushes & Washes
Drawing with Naturalistic Pen, Ink, Wash

Overview: Start with a placed image 
as a template; create a custom calli-
graphic brush; create variations on the 
brush to apply to strokes; add a wash 
layer below the ink layer.

1

It’s easy to create spontaneous painterly and calligraphic 
marks in Illustrator—perhaps with more flexibility than 
in many pixel-based programs. Sharon Steuer drew this 
sketch of Honfleur, France, using a Wacom tablet, her Art 
Pen for the Intuos4, and two different Illustrator brushes. 
She customized a brush for the thin, dark strokes and 
used a built-in brush for the underlying gray washes.

1 Placing artwork as a template. If you want to use a 
sketch or photo as a reference as you draw into layers 
above, set it up as a non-printing template layer. For her 
template image, Steuer scanned a small photo of Honfleur 
and saved it as a JPG, then opened it in Illustrator. To 
place an image as a template, choose File> Place, enable 
the Template option, and click the Place button. If the 
image imports at too large a size, unlock the layer, select 
the image (holding down Option-Shift/Alt-Shift keys to 
resize proportionally from the center), and drag on a cor-
ner of the bounding box until the image is the size you 
want, then lock the layer again. Illustrator automatically 
dims images on your template layer to 50%, but you can 
double-click the layer icon to adjust this and other settings 
in Layer Options. Toggle between hiding and showing the 
template layer using C-Shift-W/Ctrl-Shift-W, or toggle 
the visibility icon in the Layers panel. 

(Top) The original photo; (bottom) brushstrokes 
drawn over the dimmed template photo

Transparent brushstrokes

By default, calligraphic brush-

strokes are opaque. You can 

also draw with semi-transparent 

brushstrokes, which you can use 

to simulate some types of inks or 

watercolors; where marks overlap, 

they become richer or darker. Click 

Opacity in the Control panel to 

reduce opacity or choose a blend-

ing mode. 
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2 Customizing a calligraphic brush. In order to sketch 
freely and with accurate detail, you’ll need to adjust the 
default Paintbrush tool settings. Double-click the Paint-
brush tool to open Paintbrush Tool Options. Drag the Fi-
delity and Smoothness sliders all the way to the left so that 
Illustrator records your strokes precisely. Disable “Fill new 
brush strokes,” and if you want to be able to quickly draw 
strokes that overlap, disable Keep Selected.

To create a custom calligraphic brush, click the New 
Brush icon and select Calligraphic Brush. For this piece, 
Steuer chose the following settings: Angle=90°/Fixed; 
Roundness=10%/Fixed; Diameter=4 pt/Pressure/Varia-
tion=4 pt. If you have one of the newer Wacom Art Pens, 
try varying the Diameter with Rotation instead of Pres-
sure, then let the pen barrel rotate between your fingers 
naturally as you draw. (If you don’t have a pressure-sen-
sitive tablet, only Random will have any effect on varying 
your stroke.) To create a variation of a brush, duplicate it 
by dragging it to the New Brush icon, then double-click 
the copy to edit it. If you create a variety of brushes—add-
ing minor variances in Angle, Roundness, and Diame-
ter—you can enhance the hand-drawn appearance of your 
ink drawing by selecting a brushed path and choosing a 
new brush for it.

3 Adding a wash. For this piece, Steuer added depth by 
introducing gray washes underneath the dark brush-
strokes. To easily edit the wash strokes without affecting 
the dark ink strokes, create a new layer, and draw your 
wash strokes into this layer between the ink and template 
layers. To avoid altering other layers while you brush in 
the washes, you may want to lock all the other layers. To 
toggle between locking all layers except the wash layer, 
and unlocking all layers at once, including the wash layer, 
Option-click/Alt-click the wash layer’s Lock icon. 

For the wash, select a light color. Steuer used the Dry 
Ink 2 brush from the Artistic_Ink brush library (Swatch 
Libraries menu). In the Layers panel, click the wash layer 
to make it the current drawing layer, and paint away.

2

Customizing the Paintbrush Tool Options

Creating a new calligraphic brush

Angle, Roundness, and Size can be set to a vari-
ety of Pen characteristics (including Rotation, Tilt, 
Bearing), but you can only make use of these fea-
tures if your tablet, and Art Pen, support them

The final ink drawing after adding a couple of 
people not in the original photo, and before 
adding the wash
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positions. The sliders moved farther to the 

left had more accurate brushstrokes, while 

those moved to the right were smoother. The 

“Fill New Brush Strokes” and “Keep Selected” 

options were disabled to allow multiple brush-

strokes to be drawn near each other without 

redrawing the last path. Using a pressure-sen-

sitive tablet, the students drew varying widths 

and angles of brushstrokes, many either on top 

of or close to one another, for a spontaneous, 

expressive look. Extra points within the brush-

strokes were deleted using the Smooth tool or 

the Delete Anchor Point tool. 

Stephen Klema’s Students:  

Jillian Winkel, Stephanie Pernal,  

Amber Loukoumis, Jeffrey Martin,  

Nicole Dzienis, Tamara Morrison

(clockwise from upper left)

As a class assignment, Professor Stephen Klema 

challenged his students to create expressive 

graphic illustrations of organic forms. The 

students of Tunxis Community College used 

a variety of default brushes from the brushes 

panel. They included both calligraphic and art 

brushes. Before drawing, the students double-

clicked the Paintbrush tool and adjusted the 

Paintbrush tool preferences. They dragged the 

Fidelity and Smoothness sliders to the desired 

WINKEL MORRISON

DZIENISPERNAL

LOUKOUMIS MARTIN
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Stephen Klema’s Students: 

Cinthia A. Burnett, James Cassidy,  

Kenneth Albert, Jamal Wynn,  

Suzanne Drapeau, Mahalia Johnson

(clockwise from upper left)

Using the same techniques described on the 

previous page, additional student creations are 

shown above. In some of these illustrations, art-

ists applied art and calligraphic brushes to paths 

drawn with the Pencil or Pen tools, by select-

ing the path, and then choosing a brush from 

the Brushes panel. You can find many addi-

tional brushes in the Brushes library. To access 

more art brushes, click on the Brush Libraries 

Menu icon found in the lower left corner of 

the Brushes panel. Select Open Brush Library> 

Artistic, then select the brushes you want to 

add to the Brushes panel. Find more artwork 

from Professor Klema’s students on his website 

at: www.StephenKlema.com/wow.

CASSIDY

ALBERT

DRAPEAU

DRAPEAU

WYNN

JOHNSONBURNETT
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Sharon Steuer

To create this illustration for her “Good Food in 

the Microhood” UntappedCities.com posting, 

Sharon Steuer began in Photoshop, where she 

collaged photos she’d taken from different van-

tage points into one imaginary citiscape. After 

placing it as a JPG template in Illustrator, from 

another image, she copied objects styled with 

her custom calligraphic brushes and pasted the 

objects into her new file, which added the cus-

tom brushes to her current Brushes panel. She 

then deleted the objects and used these brushes 

to paint her black line drawing. In a new layer 

she added color using default bristle brushes 

and a pressure-sensitive Wacom tablet and Art 

Pen. To easily switch between brushes, colors, 

and layers, she started by selecting a path styled 

similarly to the one she wanted to make, then 

deselected (C-Shift-A/Ctrl-Shift-A). To draw a 

new, blue, wide transparent bristle brush stroke 

on the Color layer, she selected a blue-wide 

stroke on the Color layer, then deselected, and 

drew. Next, to draw a new calligraphic path on 

the lines layer, she selected then deselected one 

of those. With Edit Selected enabled in Brush 

Options, if she kept a brush stroke selected, she 

could redraw the path (instead of draw a new 

one). After adding a few more detail layers, she 

created an “unwanted lines layer” and hid it, so 

she could then select and move unwanted lines 

to that hidden layer. Lastly she created two 

overlapping artboards: one to frame the crop 

when featured on the website front page, and 

the other sized for insertion within the post. To 

see this posting, which also contains a link to an 

article on CreativePro.com detailing how this 

image was created, go to UntappedCities.com 

and enter “CreativePro” in the search field. 

ST
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Sharon Steuer

For her UntappedCities.com “Good Food in the 

Microhood” article on San Francisco's Tender-

loin restaurants, Sharon Steuer used Photoshop 

to stretch, crop, and color-correct her photo of 

the Vietnamese soup called “phở.” She placed 

the photo in Illustrator off the artboard (as a 

reference), and used the Pen tool to draw a 

few closed paths (filled with gradients). Locking 

that first layer with the objects and photo, she 

created additional layers, where she painted 

her image using two bristle brushes at default 

settings (one Angle and one Mop), and a cus-

tom calligraphic brush. As the image progressed 

Steuer decided to modify the bowl's shape in 

ways that would be difficult with traditional or 

raster tools; she selected the bowl objects, then 

compressed them vertically using the bounding 

box. After the article posted, she reworked the 

image as a fine art piece titled “Vegan phở.” 

Resizing some elements and adding others, she 

printed a square variation in archival materials. 

Coating the print with clear acrylic medium, 

Steuer cut and collaged it onto a 6"x6" cradled 

board, and then drew and painted on the sur-

face with watercolor pencils. She applied fixa-

tive and a UV coating to the finished artwork.

ST
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Painting Inside
Painting with Bristle Brushes & Draw Inside

Advanced Technique

Overview: Start with a placed image 
as a reference; create a line drawing 
made of closed paths; use a variety of 
bristle brushes and the Draw Inside 
mode to paint the sketch; add a rect-
angular background with a Charcoal 
art brush edge.

1
Draw Inside mode makes it easy to create a painterly 
illustration with bristle brushes. Lisa Jackmore drew this 
sketch of an artichoke, using a Wacom tablet with her Art 
Pen, and several modified brushes. After drawing a simple 
outline of the artichoke leaves and the stem with the Pen-
cil tool, she utilized the Draw Inside mode and painted 
with a range of bristle brushes.

1 Drawing the outlines. Jackmore used a snapshot as a 
basic reference, but if you prefer to draw directly on top 
of a photo or drawing use File> Place and enable the Tem-
plate option. In order to create a fluid but accurate line 
drawing she double-clicked the Pencil tool to set Options 
for Fidelity to 3 pixels, Smoothness to 3%, and disabling 
Edit Selected Paths and Keep Selected. Into one layer she 
created a 1-pt line drawing of the artichoke using the Pen-
cil tool, making sure that she closed each leaf and stem 
path so that she would later be able to add detail and color 
the loosely-drawn paths using the Draw Inside mode.

2 Setting up for painting using the bristle brush tool 

and a tablet. So she’d be able to paint freely and easily, 
Jackmore planned ahead and first set up her tools. She 
opened the Brushes panel, the Bristle Brush Library (from 
the Libraries menu), and the Layers panel. She also set the 
Wacom tablet’s Touch Ring to auto scroll/zoom. 

JA
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The closed path line drawing created with the 
Pencil tool using a 1-pt stroke

Re-enter isolation mode 

When you use the Draw 

Inside mode (bottom of 

the Tools panel or Shift-D), 

you’re actually creating a special 

kind of clipping mask. Once you’ve 

“drawn inside” an object, double-

click it to enter into isolation 

mode and automatically re-enter 

Draw Inside mode to add to the 

object. To remove a “drawn in-

side” clipping mask from an object 

and return the object to its origi-

nal state, select Object> Clipping 

Mask> Release.
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3 Painting with bristle brushes and the Draw Inside 

mode. To draw into a path, she selected it, pressed Shift-
D to choose the Draw Inside mode, then deselected the 
path (so the bristle brush wouldn’t be applied to the out-
line, but would be constrained within the path). She se-
lected the Paintbrush tool (B), then chose a bristle brush, 
and a stroke color. When she finished drawing inside a 
path, Jackmore pressed Shift-D to switch back to Normal 
drawing mode. She switched between the Paintbrush tool 
and the Selection tool by holding the C/Ctrl key to tem-
porarily switch to the Selection tool, and toggled between 
drawing modes with Shift-D. Jackmore created a number 
of variations of the Round Point, Fan, Round, and Flat 
Blunt bristle brushes. To customize parameters for opac-
ity, Bristle Length, Stiffness, and Thickness, she’d open 
Options by pressing the upper switch on the Intuos4 Pen 
(or double-clicking the Paintbrush tool). With the Paint-
brush tool selected, she decreased/increased brush size 
with the [ ] keys, adjusted opacity with the number keys, 
and zoomed in or out by turning Wacom tablet’s Touch 
Ring clockwise, or counter–clockwise.

4 Organizing layers and finishing details. To reveal the 
correct part of the leaf as it overlapped another, as she 
worked, Jackmore moved each leaf into its appropriate 
layer. As each leaf and stem became painted enough to 
see the entire path, while in Normal drawing mode she 
set the stroke to None. To fine-tune the painted area for a 
particular leaf, she double-clicked on that leaf to automat-
ically enter into isolation mode while already in Draw In-
side mode, allowing her to continue to paint and modify 
brushstrokes. For the background, on a layer below Jack-
more drew a rectangle, with the same fill and stroke color 
and applied a 3-pt Charcoal art brush stroke. To more 
fully distribute the brushstroke, she slightly rotated a du-
plicate of the stroke by first clicking the Add New Stroke 
icon in the Appearance panel (to add a stroke), and from 
the fx menu she chose Distort & Transform> Transform 
and entered 180° for rotation.

3

4

Some of the bristle brushes in the Brushes panel; 
selecting a leaf to Draw Inside; bristle brush icon 
while drawing inside the leaf

Double-clicking a leaf to enter isolation mode 
and automatically switch to Draw Inside mode

Detail of the lower right corner of the back-
ground before and after adding a second, ro-
tated Charcoal art brush stroke
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The myriad bristle brushes presented Greg Geisler with an 
infinite variety of brushes to create his expressive painterly 
portrait, “Blue Mirror.” Commissioned by Adobe Systems, 
you can find this file, and a PDF ReadMe file explaining 
more about how he made it, on WOW! ONLINE. 

1 Placing the initial sketch, and customizing Bristle 

Brush Options. Geisler placed his distorted Photoshop 
sketch (PSD) as a Template layer. He opened the Bristle 
Brush Library (from the Brush Libraries Menu in the 
lower left of the Brushes panel) and clicked on the 1-pt 
Round bristle brush, which automatically loaded the 
brush into the Brushes panel. Geisler next duplicated that 
brush (by dragging its icon to the New Brush icon in the 
Brushes panel) and then double-clicked on the New Brush 
icon so he could change several settings in Bristle Brush 
Options. He made changes to Bristle Thickness, adjusted 
Paint Opacity and increased the Stiffness, and then named 
it and clicked OK. On a layer above the template, he used 
this new brush to create the base sketch for the entire il-
lustration. Geisler kept the Brushes panel and the Bristle 
Brush Library open throughout the drawing session, so he 
could continue to duplicate and customize brushes as his 
drawing progressed. For this layer, he created three differ-
ent variations of the 1-pt Liner brush. 

Painterly Portraits
Painting in Layers with Bristle Brushes

Advanced Technique

Overview: Place a sketch as a tem-
plate; draw with customized bristle 
brushes; continue to paint with cus-
tom brushes into separate layers; cre-
ate frame.

G
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Adding shadows with a wide, fairly opaque 
bristle brush

The template; a distorted Photoshop sketch

1

The initial bristle brush sketch made with three 
variations of a Round Point bristle brush; the 
Bristle Brush Options 
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2 Adding highlights, midtones, and shadows. To make 
one of the many layers of highlights, such as the strokes 
in orange, Geisler customized copies of the 3-mm Flat 
Fan Brush in the Bristle Brushes Library, adjusting Bristle 
Thickness, Bristle Length, and Paint Opacity. He also 
drew highlights with a Round bristle brush customized 
with Pointy variations. Geisler continued to draw in sepa-
rate layers, focusing in particular on midtones, shadows, 
highlights, or color for each layer, using variations of the 
Flat Fan and Round bristle brushes.

3 Working efficiently and further modifying brush 

characteristics. Geisler’s process is very organic in that 
he continually defines new brushes, and creates new lay-
ers, as he draws. He rarely deletes a stroke, preferring to 
layer new bristle brushstrokes upon others, choosing a 
more opaque brush to cover the underlying strokes. As 
he’s drawing, he presses the [ key to decrease the brush 
size, and the ] key, to increase the bristle size. To vary the 
opacity, he presses the keys from 1, which is completely 
transparent, through 0, which is completely opaque. To 
add texture, as in the blue background shown at right, 
Geisler modifies the settings to increase the brush stiff-
ness toward Rigid, increase the brush density toward 
Thick, and then decrease the bristle length.

4 Finishing touches. Geisler created an irregular edged 
black frame that surrounded the portrait, on a layer be-
tween the blue texture and the face. He customized a wide 
Flat Fan brush to 100% Opacity (100% opaque bristle 
brushes lose their character within the stroke, but main-
tain a ragged edge), and then expanded the brushstrokes 
(Object> Expand) and clicked Unite in the Pathfinder 
panel, melding the brushstrokes into one frame object. 
He then used the Pencil tool to draw a few closed paths, 
delineating the area between the rectangular frame and 
the head. Marquee-selecting these paths and the frame, 
he filled them with black, and again clicked Unite in the 
Pathfinder panel. 

3

4

2

Adding highlights with a Wide Fan Brush, add-
ing shadows; the bristle brush icon that appears 
when using a pressure sensitive pen

Part of the Brushes panel (right), and a later 
stage of the illustration with blue texture

Black frame made with expanded bristle brush-
strokes and filled paths shown in Preview mode 
(detail at left), and Outline mode (right) 
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Greg Geisler

Greg Geisler created this graphic self-portrait 

using a customized calligraphic brush. In the 

Brushes panel, Geisler double-clicked the 

default 3-pt round calligraphic brush, and for 

the Diameter settings, he changed Fixed to 

Pressure, and set the Variation to 3 pt. Using 

a Wacom tablet and pressure-sensitive pen, 

he drew the facial outline, varying the stroke 

width as he changed his touch (directly above 

left). To block out planes of color within the 

face (such as the chin, beard, and cheek), 

he used the Pencil tool to draw color-filled 

irregular paths on separate layers. Each layer 

contained one of the many defining areas of 

color (Layers panel shown above right) for 

highlights, shadows, or texture. To create the 

frame, Geisler used the same bristle brush, and 

a technique similar to the one developed in the 

previous lesson (shown below the artwork). For 

finishing touches, Geisler drew the bright blue 

squiggly lines with the Pencil tool.

GEISLER
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Janaína Cesar de Oliveira Baldacci

Based on a photograph taken by Tatiana 

Bicalho, Baldacci captured the natural undula-

tions of the fur and folds of her pet bulldog 

with bristle brushes. Baldacci first drew a 

white outline of the dog (against the black 

background) with the Pen tool and applied a 

Gaussian Blur effect. From the Brush Libraries 

Menu (in the bottom left of the Brushes panel), 

Baldacci opened the Bristle Brush Library. She 

then chose a few bristle brushes that had 

varying characteristics in Paint Opacity, Bristle 

Stiffness, and Bristle Density, such as Round 

Fan, Flat Blunt, Flat Point, and Round Curve 

(a portion of her Brushes panel shown above). 

Baldacci then selected the Paintbrush tool (B), 

chose a bristle brush and a stroke color, and 

drew into the first of many layers (the image 

on the first layer is shown above in Preview 

and Outline modes). In layers above, she added 

greater definition and built the fur in stages 

based on color, such as white, gray, and high-

lights. On the uppermost layers she added the 

snout, eye details, and additional layers of fur 

until the portrait was complete.

CESAR de OLIVEIRA BALDACCI
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Overview: Create the parts that will 
make up a pattern brush separately; 
place the parts in the Swatches panel 
and give them distinctive names; use 
the Pattern Brush Options dialog to 
create the brushes; vary the width of 
the pattern brush line using the Stroke 
menu and the Width tool.

Pattern Brushes
Building Characters with Pattern Brushes

1

To create these stylized science-fiction robots, Raymond 
Larrett saved extensive tedious rendering by building the 
robot limbs using a custom pattern brush. Working this 
way allows him to quickly and easily make alterations to 
his art by adjusting the weight of the brush stroke, modi-
fying or replacing the various brush elements, or even 
replacing the entire brush itself. 

1 Creating the robot arm parts. Larrett’s robot arm re-
quired four distinct elements: a “shoulder” piece where 
the arm joins the body, an “elbow” connecting the upper 
and lower arm, the “hand” (in this case a claw), and an 
“arm link” segment that replicates as it connects and forms 
the majority of the robot arm. He created these pieces in-
dividually, then turned each into a separate pattern swatch. 
These swatches become the “tiles,” that together make up 
the robot arm pattern brush. 

To create the shoulder piece, he first modified a shape 
made with the Ellipse tool. Using the Pen tool, he drew a 
lighter, unfilled path with a Round Cap for the highlight 
to complete the shoulder. He then dragged the shoul-
der art into the Swatches panel, naming it “shoulder” so 
he would recognize it as he built the pattern brush. In 
the same way he created the arm link, hand, and elbow 
swatches for the pattern brush tiles. He made sure that 

Adjusting pattern brush fit

After you’ve applied a pattern 

brush to a path, you can still scale, 

flip, and modify its fit along the 

path. Modify all these settings in 

the Pattern Brush Options dialog, 

or manually reshape and scale the 

pattern by changing the stroke 

weight or using the Width tool. 

Creating the various robot arm elements, ori-
ented in the outward-facing position that pattern 
brushes use for their tiles

Dragging objects for pattern brushes into the 
Swatches panel and naming them
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2

Using the Width tool to introduce variations in 
the width of your pattern brush line

Recombining and building new swatches to 
create new pattern brushes

Using the Stroke panel to widen or narrow the 
pattern brush line weight

Creating a new pattern brush by placing the 
swatches in the appropriate tiles

Selecting the Pattern Brush option from the New 
Brush dialog

the various pieces were facing in the correct direction 
relative to the pattern tiles, which run at right angles to 
the path, before individually dragging each one into the 
Swatches panel (alternatively, you can select art and click 
the New Swatch icon, or choose Object> Pattern> Make).

2 Making and using the pattern brush. To build the pat-
tern brush for the robot arm, Larrett opened the Brushes 
panel, clicked New Brush in the Pattern Brush Options 
dialog, and then clicked OK. He enabled the first box in 
the panel (the Side Tile), and when prompted selected the 
pattern swatch for the arm link. Next he placed the other 
tiles in the appropriate position: the shoulder to the Start 
Tile box, the hand in the End Tile box, and the elbow in 
the Inner Corner Tile box. He named the new pattern 
brush Robot Arm, and clicked OK. 

To use his new pattern brush, Larrett selected the brush 
in the Brushes panel, then drew a path for the robot arm 
using the Pen tool (P). He clicked where the Start Tile (the 
shoulder) should go, clicked again to place a corner anchor 
point (necessary for the elbow tile, the Inner Side Tile, to 
load), and finally clicked to place the hand element (the End 
Tile) at the end of the path. He also sometimes drew with 
the Paintbrush tool or applied the brush to a drawn path.

3 Creating variations in the pattern brush. Larrett then 
modified the art by varying the pattern brush line weight 
and stroke profiles. To adjust the width of a selected robot 
arm, he changed the line weight in the Control panel or 
Stroke panel by clicking in the numeric field and using 
the up arrow and down arrow keys to increase or decrease 
stroke weight as desired (adding the Shift key alters the 
weight by increments of 10). To manually adjust only se-
lected portions of the robot limb, Larrett used the Width 
tool (Shift-W). Placing the tool over a point on a path, he 
moved the diamond-shaped handles to widen or narrow 
a portion of the path. Lastly, he combined some old and 
newly-made swatches to create additional brushes for 
other robots’ limbs.

3

The Adobe Illustrator CS6 WOW! Book by Sharon Steuer. Copyright © 2013. Pearson Education, Inc. | Peachpit Press.



 116 Chapter 4 Expressive Strokes

G A L L E R Y

Aaron McGarry

For this urban portrait Aaron McGarry relied 

heavily upon Illustrator’s Symbol Libraries and 

Symbols panel. He made his own panel contain-

ing only the symbols he needed using Window> 

Symbol Libraries> User Defined. He saved as a 

symbol any detail that he would need to repeat 

so he could easily access and apply that ele-

ment. To build the roof tiles in the background 

building, McGarry made one tile and filled it 

with a solid color. He then made two duplicates 

and filled each with a different color. He sepa-

rately dragged and dropped each into the Sym-

bols panel, named it, and clicked OK. He was 

then able to quickly drag alternating tiles from 

the panel to lay the roof, giving it a natural 

look. To create the red plumbing in the fore-

ground, he also used many duplicated parts, 

such as the nuts and bolts holding the assembly 

together, that he had saved as symbols (see 

detail above right). McGarry took full advan-

tage of Illustrator’s Symbol libraries to create 

the greenery and curb area around the pipes. 

He used grass, leaves, and rocks found in the 

libraries accessed from the Symbol Libraries icon 

in the Symbols panel. To create a perspective 

point of view he modified some of the symbols; 

for instance, he used Effect> Distort & Trans-

form to turn Rock symbols into paved concrete. 

He also created the oil stains on the road by 

modifying a Dot Pattern symbol from Illustra-

tor’s library. For the dirt on the vehicle, he drew 

a path around its lower side, then enabled the 

Draw Inside drawing mode. Using the Symbol 

Sprayer tool he sprayed the sand symbol within 

the path along the vehicle’s side. Lastly, he 

selected the path and reduced the opacity. 
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chain vertically. He selected and grouped each 

bead, and then in some cases he put the beads 

in pairs and then grouped a pair of beads. For 

each bead or pair of beads Yukio clicked the 

New Brush icon at the bottom of the Brushes 

panel, selected New Pattern Brush, and clicked 

OK. In the Pattern Brush Options dialog, he 

kept the Colorization method as None, and 

then under Fit he chose Stretch to Fit. To make 

the necklace, Nobuko drew a path with the 

Paintbrush tool and selected the desired bead 

pattern brush in the Brushes panel to apply the 

brush. Now with the bead as a pattern brush, 

the necklace can be easily adjusted to any 

length or path.

Nobuko Miyamoto/Yukio Miyamoto

Making these intricate beaded necklaces at 

first glance would seem impossibly difficult, 

but once they carefully construct each gem, 

with the use of pattern brushes, the neck-

lace virtually draws itself. Nobuko Miyamoto 

designed the necklace and created the bead 

elements (details above right) with a mixture 

of blended and solid filled objects. She paid 

careful attention to the ends of the bead to 

ensure that when each bead lined up with 

the next one there would be a seamless con-

nection between them. Yukio Miyamoto then 

transformed Nobuko’s designs into brushes. To 

make the chained ends, he selected the chain 

object and dragged a copy (Shift-Option/Shift-

Alt) to the other side of the bead. With the 

chain selected, he chose the Reflect tool and 

clicked above and below the chain to reflect the 

M
IY

A
M

O
TO

The Adobe Illustrator CS6 WOW! Book by Sharon Steuer. Copyright © 2013. Pearson Education, Inc. | Peachpit Press.



 118 Chapter 4 Expressive Strokes

G A L L E R Y

TA
N

Moses Tan

Moses Tan recreated astonishing 

detail and captured a precise like-

ness of his photographic reference 

using mostly meticulously-drawn 

filled paths, but he used custom 

art and scatter brushes for some 

of the intricate details (such as the 

weeded area shown across, right). 

He preferred to use scatter brushes 

for the small-sized growth and 

art brushes for the larger foliage. 

To make an art or scatter brush 

he first drew a weed object, then 

dragged it into the Brushes panel 

and in the New Brush Options, 

selected Art Brush or Scatter Brush 

(several are shown at right). For 

art brushes he specified the stroke 

direction (either top to bottom 

or left to right) so when he drew a 

brushstroke, the foliage was oriented 

correctly. He kept the other param-

eters at the default settings. For the 

scatter brushes he varied options 

for each weed (size, spacing, scatter, 

and rotation). For scatter brushes he 

used Page for “Rotation relative to,” 

and to preserve the original artwork 

colors in all his brushes, he used a 

Colorization of None. To paint with a 

brush he would select the Paintbrush 

tool, a scatter or art brush, and draw 

paths to easily form the weeded 

detail in his drawing.
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° (degree symbol), 3D dialog 
rotation, 155

1P Normal View, Perspective 
Grid, 159

2D shapes. See 3D effects
2P Normal View, Perspective 

Grid, 159
3D effects

changing perspective, 156
examples, 164, 166–168
extruding 2D object, 155–156
mapping art onto object, 158–159
overview of, 154–155
revolving object around its Y 

axis, 156
rotating 2D or 3D objects in 3D 

space, 156
surface shading of 3D 

objects, 157–158
types of dialogs, 155

3D programs, 226, 249
3D Studio Max, 66–67, 255
3P Normal View, Perspective 

Grid, 159
6D Art pen, 87, 93, 97
9-slice scaling, applying to symbols, 

91, 228

A
Abutting as the Method, Image 

Trace, 59
Acrobat, Adobe, 226
active plane, Perspective 

Grid, 160–161
Actual Size zoom command, 

artboards, 11
Add Anchor Point tool, 141, 

143, 145
Adjustment layers, 225, 241, 252
Adobe

Acrobat, 226
After Effects, 247, 249
Edge, 226
Ideas, 228
InDesign, 225–226, 233
Kuler. See Kuler
Photoshop. See Photoshop

Adobe Illustrator Clipboard 
(AICB), 223

 The Adobe Illustrator CS5 WOW! 
Book cover, 215

The Adobe Illustrator CS6 WOW! 
Book cover, 198

Adobe PDF Options dialog, 226
Advanced techniques, in book 

organization, xviii
After Effects, 247, 249
Ahuja, Anil, 101, 169, 172–173
AICB (Adobe Illustrator 

Clipboard), 223
alignment

Align panel, 59–60
to artboard, 20
center icon for curving label, 43
to page, 188
to path, 188
to pixel grid, 227
stroke gradient options, 124

anchor points
Butt cap causing path to end 

at, 86
creating blends with point 

map, 187
removing excess from paths, 60
tracing template layer, 12–13
width points vs., 85

angle, customizing Calligraphic 
brush, 103

animation
creating artwork inside Illustrator 

for Flash, 229
creating from layers, 

228, 242–243
symbol, 244–245

anti-aliasing, 226, 227
Appearance panel

disabling New Art Has Basic 
Appearance setting, xvii

working with, 8–9
Application Frame, tabbed docs 

and, 2
apps. See combining apps creatively
Arc tool, 13, 21
Architectural Elements Vector Pack, 

Go Media, 251
architectural rendering

finishing touches on, 250–251
perspective in, 176–178
from photo, 178

arcs
adding to type, 46–47
creating guides for, 20–21
drawing arch, 21
setting type on curve and 

warping type, 43
tracing and adjusting curved 

paths, 13

Area Type
accessing Type Options dialog 

for, 33
graphic novel cover design, 37
overview of, 26–27
working with threaded 

text, 28–29
wrapping around objects, 29

arrowheads, 84–87
Art Brushes

creating, 89
examples of, 104–105, 118
working with, 87–88

Art Deco Golden Gate Bridge 
poster, 24

Art Pen. See also 6D Art pen
Bristle Brush responding well 

to, 93
brushes and washes 

illustration, 102
Calligraphic/Bristle brush 

illustration, 100
customizing Calligraphic 

brush, 103
“Good Food in the Microhood” 

illustrations, 106
painting with Bristle Brushes and 

Draw Inside, 108
Artboard ruler, 4
Artboard tool (Shift-O)

building from simplicity to 
complexity, 14–15

creating an identity, 38–39
creating and managing artboards 

manually, 10
naming active artboard, 10
placing non-global guide 

within, 4
artboards

applying guides globally/
individually to, 4

clipping masks for multiple, 191
copying art between, 11
creating identity with 

multiple, 38–39
creating web graphics using 

multiple, 226–227
duplicating elements to 

multiple, 34
limiting objects to be saved 

as web images on 
current, 230

managing multiple, 9–11, 34
renumbering, 34
resizing with Artboard Resizer, 79
saving project stages for 
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presentation, 78
sharing libraries and, 39
streamlining file output 

with, 40–41
artwork

auto-scaling, 22–23
copying and duplicating with 

artboards, 39
copying and pasting in Draw 

Inside mode, 62
copying between artboards, 

11, 34
creating complex layered 

patterns in 
PEM, 196–197

mapping onto object, 158–159
moving or copying a specified 

distance, 34
overlapping across multiple 

artboards, 11
overlapping artboards onto one 

piece of, 11
placing as template, 102
placing from Illustrator into 

inDesign, 225
placing in book layout, 37
preparing for finishing in 

Photoshop, 253
recoloring and editing in Live 

Color, 126–128
storing as symbol, 90

Assign tab, Recolor Artwork, 
126–128, 133, 148

Atteberry, Kevan, 238–
241, 244–245

attributes
appearance, 18
avoiding formatting 

overrides, 30
copying using Eyedropper with 

type objects, 31
formatting text, 29–30
graphic style, 9
stacking order of, 8
visibility of, 9

Aubé, Jean, 216
Auto Collapse Icon Panels, 3
Auto-Exit Pattern Editing 

Mode, 180
auto-scaling artwork, 22–23
Avenza MAPublisher plug-

ins, 132
averaging endpoints, 60

B
background, 49
Baldacci, Janaína Cesar de 

Oliveira, 113
banners, creating for curved 

labels, 42–43
base color, Live Color, 121–122, 

127, 129
Baseline Shift, setting type on 

curve, 27, 43–44
Basic Appearance. See also 

New Art Has Basic 
Appearance, 9

Basic Brush, using Width tool 
with, 98

bevels
Bevel & Extrude effect, 52
Bevel join, in Stroke panel, 86
customizing, 155
extruding 2D object and 

adding, 156
bleeds, 36–37
Blend Options dialog, 187–188
Blend tool

creating blend or adjust 
settings on existing 
blend, 186–187

creating PhotoRealistic 
complex graphic, 218

point maps using, 187
using transparency for 

highlights, 202
using transparency for 

highlights and 
glows, 205

blending modes
 The Adobe Illustrator CS5 

WOW! Book 
cover, 215

coordinating scenes for 
different times of 
day, 163

creating dragonfly image, 101
ePublishing with InDesign 

cover, 220
“Falling” complex graphic, 216
Golden Gate Bridge 

anniversary poster, 24
opacity and, 184
Pit Bull poster, 52
transparency referring to, 183

blends
in 3D dialog, 155
along a path, 188
Blend Options, 187–188
California Magazine complex 

graphic, 214
creating 3D version of 2D 

object with, 164
inserting objects into, 188
mastering, 186–188
overview of, 186–187
shaping glows with, 205

Blind Men and the Elephant 
illustration, 96

Blob Brush tool (Shift-B)
Adobe Illustrator CS5 WOW! 

Book cover, 215
combining object with same fill 

attributes, 55–56
converting objects into Live 

Paint Groups, 69
fast shading with, 81
in Pit Bull poster, 52
protecting objects from, 55
sketch using Live Paint 

and, 68–69
sketch with Eraser tool and, 71
sketch with Wacom® tablet 

computer and, 70
strokes applied with, 84
tracing sketch with, 68–69
using Image Trace and, 75

“Blue Mirror” painterly 
portrait, 110–111

Blur. See also Gaussian Blur
constructing shadows in 

3D, 167
creating type objects for 

characters, 49
making and applying 

appearances, 18
map with terrain image, 45

brackets, Path type, 27
Break Link button, Controls 

panel, 91
Break Link on Symbol, Symbols 

panel, 91
Brick layout, 182, 197
Bristle Brush library, 79

artboards, continued
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Bristle Brushes
 The Adobe Illustrator CS5 

WOW! Book 
cover, 215

applying stroke gradient to, 124
creating architectural 

rendering from 
photo, 178

creating graphic self-
portrait, 112

emulating paint brushes, 89
“Good Food in the Microhood” 

illustrations, 106–107
graphics tablets and, 87
painterly illustration with 

Draw Inside 
and, 108–109

painterly portrait, 110–111
painting fur and folds of 

bulldog, 113
responding to Art Pens, 93
variations of, 100

Brush tool (B), 79, 87, 90
brushes

Art Brushes, 87–88
Bristle Brushes, 89
Calligraphic Brushes, 87
editing with Live Color, 126
functional features of, 89–90
Pattern Brushes, 88–89
Scatter Brushes, 88

Brushes library, 105
Bryan, Billie, 50
Burke, Pariah, 220
Butt cap, Strokes panel, 86

C
Cadtools, 236
California Magazine cover, 214
Calligraphic brushes

applying stroke gradient to, 124
creating dragonfly image, 101
creating fluid floral design 

with, 98
customizing, 103
customizing for graphic self-

portrait, 112
“Good Food in the Microhood” 

illustrations, 106
graphic illustrations of organic 

forms, 104–105
variations of, 100
working with, 87

calligraphic strokes
Blob Brush tool creating, 56
Calligraphic Brushes 

mimicking, 87
Eraser and Paintbrush tools 

creating, 54
caps

extruding 2D object and 
adding, 156

gallery examples of, 96, 99
Strokes panel styles, 86–87

Cartagram, LLC
applying shadows to map 

icons, 7
Kuler colors, 120, 134–135
labeling curving features on 

maps, 44
making and applying 

appearances, 18–19
navigating layers, 16–17
scripting colors, 132–133
setting type on terrain 

images, 45
Change to Global/Artboard 

ruler, 4
Character panel, 29
Character Styles panel, 29–30
Cinema 4D, 248, 249
circles, 28, 205
cityscapes, 159–161
ClassicTrains magazine, 236
clipping masks

complex graphics with, 
200–201, 208–210, 
214, 217–218

Draw Inside mode creating, 
61–62, 80–81

overview of, 188–192
clipping paths, 189, 191–192, 210
close paths, 27
clustering panels on workspace, 2
Coghill, George, 82
color. See also Live Color

for 3D Surface Shading, 157
adding to line art 

illustration, 82
for appearances, 18–19
arc effect added to headline, 47
with Art Brushes, 88
for artboards, 40
building from simplicity to 

complexity when 
using, 14–15

combining paths with 
Pathfinder 
using, 64–65

for custom color 
groups, 130–131

for dragonfly image, 101
“Good Food in the Microhood” 

illustrations, 106
for gradient meshes, 123–125
for gradients, 143
in Image Trace panel, 59
with Live Paint, 57–58, 66–67
for PhotoRealistic complex 

graphics, 206
recoloring patterns in 

PEM, 183
with Scatter Brushes, 88
with Shape Builder, 57, 78–79
smartphone case with, 150
tools for adding and 

editing, 132–133
translating photo into layers of 

filled paths, 218
for web graphic displays, 227

color groups
creating in Kuler 

panel, 132–133
customizing, 130–131
entering Recolor Artwork 

with, 148–149
importing Kuler themes as 

new, 133, 135
overview of, 121–122
Recolor Artwork/Edit Color 

dialog options, Live 
Color, 127

saving specific set of 
colors, 127

simulating drapery folds, 144
using Assign tab to create 

variations on, 149
Color Guide panel, 121–122
Color panel

creating custom 
swatches, 130–131

gradient fills and Gradient 
Annotator 
using, 123–124

translating photo into layers of 
filled paths, 218

transparency with, 183
working with, 120–122

Color Reduction options, Recolor 
Artwork dialog, 128, 149

color stops, 147
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color swatches
building appearance for single 

object, 18
creating cartoon character, 82
custom coloring 

using, 130–131
Live brushes and, 126
Swatches panel in list view 

for, 121
color transitions

color groups and Color Guide 
panel, 121–122

gallery examples of, 129, 139, 
144–146, 150

gradient mesh, 124–126
gradients, 122–124
Live Color, 126–128
overview of, 120
working with Color 

and Swatches 
panels, 120–121

color transitions, lessons
converting gradients to mesh 

for editing, 140–141
custom coloring, 130–131
gradient paths, 138
Kuler colors, 134–135
scripting colors, 132–133
transparent mesh, 142–143
unified gradients with Gradient 

Annotator, 136–137
combining apps creatively, 

creating animation with 
layers, 228

creating web graphics, 226–228
linking vs. embedding in 

Illustrator, 222
Illustrator and Adobe 

Ideas, 235
Illustrator and Adobe 

InDesign, 225–226
Illustrator, Adobe Acrobat, and 

PDF, 226 
Illustrator and After 

Effects, 247
Illustrator and Flash, 229
Illustrator and Flash art, 246
Illustrator and iPad app 

development, 232
Illustrator and Photoshop, 

223–225 237, 
240, 254–255

Illustrator, PDF, and Adobe 
Acrobat, 226 

Illustrator, Cadtools, and 
Photoshop, 236

Illustrator, Cinema 4D, and 
After Effects, 249

Illustrator, DrawScribe/
VectorScribe, 234

Illustrator, EPUB and iBooks 
Author, 233

Illustrator, Flash, and Cinema 
4D, 248

combining apps creatively, lessons
creating animation from 

layers, 242–243
creating web page elements in 

Illustrator, 230–231
exporting layers to 

Photoshop, 238–239
Illustrator and Photoshop 

advanced 
techniques, 252–253

Illustrator, Painter, Go 
Media and 
Photoshop, 250–251

symbol animation, 244–245
complexity. See mastering 

complexity
complexity, building from 

simplicity to, 14–15
composition methods, line breaks 

in text, 31
compound paths

compound shapes vs., 61
converting type to outlines 

for, 30
creating clipping masks 

from, 189
creating complex clipping 

masks with, 208–209
creating with Eraser tool, 54
creating with Lasso tool, 135
drawing tube using, 201
overview of, 62
using as clipping mask, 192

compound shapes
compound paths vs., 61
creating complex clipping 

masks with, 209
exporting to Photoshop, 224
overview of, 62, 63
using as clipping mask, 192

consistency, symbols creating, 90
Constrain Angle, changing, 5
construction

aligning and distributing 
objects, 59–60

Blob Brush tool, 55–56
compound paths, 62
compound shapes, 63

Draw Behind and Draw Inside 
modes, 61–62

Eraser tools, 54–55
Image Trace, 58–59
joins, 60–61
Live Paint, 57–58
Pathfinder panel, 63
rethinking, 54
Shape Builder tool, 56–57

construction, gallery
book illustrations, 73
sculpture with Live Paint, 76
seed packet with Image 

Trace, 72
self-portrait with Image 

Trace, 75
sketch with Blob Brush/Eraser 

tools, 71
sketch with Blob Brush/

Wacom® tablet, 70
using Shape Builder, 77, 82
Vintage with Image Trace/

Photoshop, 74
construction, lessons

coloring line art, 66–67
path construction with 

Pathfinder, 64–65
rapid reshaping with Shape 

Builder, 78
from sketch to Blob Brush/Live 

Paint, 68–69
using Draw Inside/multiple 

construction 
modes, 80–81

container object, for custom Area 
type, 27

contiguous layers, 17
contiguous width points, 85
continuous curves, between width 

points, 84–85
Control panel

accessing Fill/Stroke swatches 
in, 120

accessing Symbol features 
on, 90

Align controls in, 59–60
editing and storing symbols 

in, 90–91
Envelope buttons in, 153
envelope mesh tools in, 153
envelope warp tools in, 153
managing multiple artboards 

in, 10
organizing workspace with, 2

Convert Anchor Point tool, 188
Convert to Artboard, 11, 35
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Cool Extras folder, 4
copy/paste

artwork in Draw Inside 
mode, 62

editing Illustrator objects in 
inDesign, 225

moving artwork from 
Illustrator to non-
Adobe programs, 223

objects into clipping mask, 189
placing artwork from 

Illustrator into 
Flash, 227

techniques, 7–8
copying

art between artboards, 11
duplicating elements to 

artboards, 34
type style and appearance 

using Eyedropper, 31
Corel Painter, sky background 

in, 250–251
corners, tracing, 12–13
Cox, Sally, 86
Create Gradient mesh, 125
Create New Layer icon, 91–92
Create New Sublayer, 16–17
Create PDF Compatible File, 

222, 225
Creative Cloud, Ideas app, 228
CreativePro.com, 34, 106
Cressy, Michael, 153, 162–163
crosshairs, transforming symbols 

and, 91
curves

creating continuous vs. 
discontinuous, 84–85

setting type on curved 
paths, 42–43

tracing and adjusting paths, 13

D
Dacosta! of Chocolate Soop®, 

40–41, 232
Daniels, Lee, 247
Darren (Winder), 139
dashed lines, 86–87
Del Vechio, Gustavo, 58, 66–67, 

178, 255
Diffused Shading option, 3D 

Surface Shading, 157

Direct Selection tool
applying Path type, 27–28
creating gradient mesh, 122
creating joins, 60
creating textured graphic, 217
making blends along path, 188
scaling text frames only, 27
tracing and adjusting curved 

paths, 13
tracing template layer, 12–13

discontinuous curves, between 
width points, 84–85

Display ruler, 4
Distort & Transform effect

applying Transform effect, 23
gallery examples using, 50–

51, 116
saving and applying graphic 

style, 47
shaping objects with, 163

Distort tools
also see Envelope Distort
shaping gradient mesh, 125
warps. See warps

distribution of objects, 59–60
Divide Pathfinder icon, 206–207
docking panels, 3
documents

accessing Document Profiles, 
xvi

App Frame and tabbed, 2
Illustrator as stand-alone 

layout tool, 36–37
modifying all instances of 

symbol in, 91
using New Document 

Profiles, 4
Dot Pattern symbol, 116
double arrow, panels, 3
double-headed arrow, panels, 3
drag and drop

creating Photoshop Smart 
Object, 224

moving artwork from 
Illustrator to non-
Adobe programs, 223

placing artwork from 
Illustrator into 
Flash, 227

symbol into document, 90
dragonfly image, 101
Draw Behind mode, 61–62, 

79, 182

Draw Inside mode (Shift-D)
 The Adobe Illustrator CS5 

WOW! Book 
cover, 215

architectural rendering from 
photo, 178

constructing objects 
with, 61–62

illustration with Bristle 
Brushes and, 108–109

masking images, 209
multiple construction modes 

with, 80–81
not using in PEM, 182
reshaping with Shape 

Builder, 79
Draw Normal mode, 186
drawing

with Appearance panel, 9
complex elements and 

attaching to 
perspective grid, 173

in perspective mode, 160–
161, 172–173

drawing modes, 61, 79
DrawScribe, 234
Drees, Dedree, 164
Drew, Elaine, 170–171
Drip.Dot.Swirl.94 incredible 

patterns for design 
and illustration (How 
Publishing), 193

Drop Shadow
3D modeling of key fob, 168
assigning appearance attributes 

to entire layer, 19
constructing shadows in 

3D, 167
ePublishing with InDesign 

cover, 220
example of, 49

duplication
of artwork with artboards, 39
of elements to multiple 

artboards, 34
of selected item, 9, 23
of textured graphic, 217
of urban portrait with 

symbols, 116
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E
Edge, Adobe, 226
edges

designing to, 10
hiding/showing, 5
refining on Blob Brush 

brushstroke, 56
removing unwanted 

intersecting, 67
Edit Clipping Path button, 

Control panel, 192
Edit Colors icon, 122
Edit Contents button, Control 

panel, 152–153, 192
Edit Envelope button, Control 

panel, 152–153
Edit> Paste, 11
Edit Selected Paths, brushes, 90
Edit Symbol button, Control 

panel, 91
Edit tab, Recolor Artwork/

EditColor 
dialog, 127–128

editing
artwork in Live Color, 126–128
clipping masks, 189–190
converting gradients to mesh 

for, 140–141
envelopes, 153
gradient mesh tools for, 141
gradient meshes in Live 

Color, 129
Illustrator objects in 

inDesign, 225
Illustrator Smart Object, 224
Kuler themes, 133
live effects, 153
opacity masks, 185
pattern swatches without 

PEM, 182–183
transparency, 185–186
unified gradients, 136–137
warps, 153

effects, duplicating, 9
Effects menu, live effects, 152
elements, duplicating to 

artboards, 34
Ellipse tool

creating arch, 21
creating banner, 42–43
creating icon, 130
creating mouth, 65
creating textured graphic, 217
reshaping with Shape 

Builder, 78

Elliptical Marquee tool, 251
embedded files, 222, 225
end cap styles, Stroke 

panel, 86–87
endpoints, creating joins 

at, 60–61
Enter Isolation Mode, Layers 

panel, 6
entourage elements, architectural 

rendering, 250–251
Envelope Distort

arcing type with, 46–47
bending forms for organic 

variations, 162–163
gallery examples of, 144–

145, 220
reshaping dimensions 

with, 153–154
envelope mesh, 153–154, 220
Envelope Options button, Control 

panel, 152–153
envelope warp, 153–154, 158, 163
envelopes

applying, 153–154
converting type to outlines vs. 

using, 30–31
warps vs., 152

EPS format, PDF format vs., 223
EPUB, 233

versions, of WOW! Books, xv
ePublishing with InDesign 

cover, 220
Eraser tool

Blob Brush tool functioning 
like, 55–56

gallery examples of using, 
71, 97

masking with multiple 
objects, 213

modifying for pressure 
sensitivity, 69

overview of, 54–55
Path Eraser tool, 55

error message, clipping 
masks, 192

Every-line Composer, 31
Exit Isolation Mode, Layers 

panel, 6
expand appearance, 124–125
Expand blends, 188
Expand Gradient to Gradient 

Mesh, 141
Export to Photoshop, 238–239

exporting
artboards, 11
multiple artboards, 35
multiple files to separate 

artboards, 40–41
to Photoshop, 183, 224
using multiple artboards 

for web 
graphics, 226–227

Extent of Grid control, 
Perspective Grid, 171

Extrude & Bevel dialog, 3D effects
creating 3D version of 2D 

object, 154, 164
extruding 2D object, 155–156
mapping symbols onto 3D 

object, 158–159
mapping to object, 155
realistic modeling, 167–168
Surface shading, 157

extrusion paths, 226
Eye icon, attribute visibility, 9
Eyedropper tool

adding transparency to 
individual mesh 
points, 143

creating gradient meshes, 122
editing gradient meshes, 141
translating photo into layers of 

filled paths, 218
using with type, 31

F
“Falling” gallery (impact of 

9/11), 216
feather effect

for fast shading, 81
forming shadows with, 201
from Photoshop to 

Illustrator, 225
soft transitions for opacity 

masks with, 212–213
Ferster, Gary, 202
Fidelity settings, Options

Blob Brush tool, 81
brushes in Brushes 

panel, 104–105
Pencil tool, 13

file output, streamlining with 
artboards, 40–41

file size, symbols saving, 90
files, linking vs. embedding, 222
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fills
adding to clipping group and 

mask, 191
adding to type objects, 32
with Blob Brush tool, 55–56
building appearance 

attributes, 18
coloring line art, 67
controlling with Gradient 

Annotator, 136–137
creating compound paths, 62
drawing with Appearances, 9
duplicating, 9
gallery examples of, 49, 50, 214
gradient fills and Gradient 

Annotator, 123–124
gradient strokes vs. 

gradient, 122–124
saving current color to 

Swatches panel, 120
WOW! Artwork Colorizer for 

automatic, 132
Find Font, 33
Fireworks, converting multiple 

artboards for, 226
Fit Artboard in Window, 11
Fit to Artwork Bounds, 22
Flare tool, 135
Flash

creating animation 
for, 242–243

creating artwork inside 
Illustrator 
for, 227–229

symbol animation, 244–245
working between Illustrator 

and, 246
working between Illustrator, 

Cinema 4D art 
and, 248

Flat Fan brush, 111
flipping, Path type to other side of 

path, 28
Floor Plane control point, 

169, 175
fonts

avoiding formatting 
overrides, 30

converting type to outlines, 31
finding missing, 33
Pit Bull poster example of, 52

formatting text, 29–30
Frankie Stein series, 238–241
Free Transform tool (E), 15, 27
Frosty Cones example, 51
fx icon, 153, 155, 218

G
Galleries, in book organization, 

xviii
gaps, handling with Live Paint, 58
Gause, Monika, 211
Gaussian Blur

constructing shadows in 
3D, 167

gallery examples of, 24, 49, 
113, 165, 218

Geisler, Greg, 52, 110–112
Gilbert, Katharine, 74, 255
Glitschka, Von R., 165, 193–

195, 234
Global Adjust, Recolor Artwork 

dialog, 128
global colors

creating cartoon character, 82
Recolor Artwork dialog 

for, 128
spot colors as, 121

global process colors, 120–121
Global ruler, 4
Global swatches, 67
glow, using transparency for, 205
Go Media, 250–251
Golden Gate Bridge

 The Adobe Illustrator CS5 
WOW! Book 
cover, 215

poster, 24
Golding, Mordy, 153
“Good Food in the Microhood” 

illustrations, 106–107
Gordon, Steven

applying shadows to map 
icons, 7

Kuler colors, 120, 134–135
labeling curving features on 

maps, 44
making and applying 

appearances, 18–19
navigating layers, 16–17
scripting colors, 132–133
setting type on terrain 

images, 45
Grace, Laurie, 242–243
Gradient Annotator

controlling fills with, 136–137
filling object with linear 

gradients, 140
gradient fills and, 123–124
linear and radial gradients 

created with, 147
toggling view to show, 124

gradient fills, 136–137, 140–
141, 146

gradient mesh
adding background, 101, 145
applying transparency 

to, 142–143
color changes with Live 

Color, 129
combining patterns with, 144
controlling color transitions 

with, 140–141
creating details with two-point 

perspective, 173
overview of, 124–126
using Envelope Distort 

with, 145
Gradient panel, 122–124
gradient strokes, 124, 138, 139
Gradient tool, 136–137, 

140, 146–147
gradients

adding to live effects for soft 
illustration, 165

basics of gradients on a 
path, 138

choosing in Color Guide 
panel, 122

controlling fills with Gradient 
Annotator, 123–124

converting to mesh for 
editing, 140–141

creating PhotoRealistic 
complex graphic, 218

editing with Live Color, 126
“Falling” complex graphic, 215
Flash preserving, 228
mapping with, 158
modifying photo to show 

next generation of 
device, 175

overview of, 122–123
realistic 3D modeling, 168
resetting to defaults, 122
simulating drapery folds, 144
unifying with Gradient 

Annotator, 136–137
Graham, Cheryl, 75
graphic novel cover design, 36–37
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graphic styles
Appearance panel and, 9
arcing type, 47
auto-scaling artwork, 23
fast shading, 81
gallery example of, 49
making and applying 

appearances, 19
saving 3D effects as 

reusable, 155
saving custom stroke profile 

as, 85
saving effect settings, 22

graphic symbols, animation, 227
graphics tablets, 70, 87–88
grayscale, opacity masks 

converted to, 185
Greater Bridgeport Transit, 42–43
Grid layout, 182, 197
grid plane control points, 

Perspective 
Grid, 159–160

grids, Illustrator, 5
Ground Level control, Perspective 

Grid, 171
Group Selection tool, 213
groups

applying blends to, 188
applying Pathfinder command 

to, 62
applying styles to, 19
isolation mode for, 6

guides
adding patterned 

background, 145
aligning symbols to, 228
applying globally or 

to individual 
artboards, 4

creating for arcs, 20–21
creating separate layers for sets 

of, 5
creating slices from, 231
customizing for layout, 37
disappearing from artboard 

when entering 
PEM, 181

distant grid control points, 174
Golden Gate Bridge 

anniversary poster, 24
locking/unlocking, 5
molding transparent mesh 

layers, 142
selecting objects and defining 

as, 5
guitar, 139

H
Hamann, Brad, 200–201
Hard Light, 150
harmony rules, 122, 127
headline text, arc effect, 46–47
help

Illustrator help, xviii
online resources, xvi

Hex layout, 182, 197
Hide panels, 2
Hide/Show Edges, 5
highlights

adding with Wide Fan 
Brush, 111

creating with transparency, 
202, 204–205

holes in objects
creating in Live Paint object, 58
creating with compound 

paths, 62
creating with Shape Builder, 56

Horizontal Level control, 
Perspective Grid, 171

HotDoor’s CADtools plug-in, 236
Hubig, Dan, 214, 252–253

I
iBooks Author (iBA), 233
icons

creating, 130
custom coloring of, 130–131
minimizing panels reduced 

to, 2–3
streamlining file output with 

artboards, 40–41
Ideas, Adobe touch app, 228, 235
identity package, creating, 38–39
Illustrator

After Effects and, 247
Cadtools, Photoshop and, 236
Cinema 4D, After Effects 

and, 249
DrawScribe/VectorScribe 

and, 234
Flash and, 227–229, 246
Flash, Cinema 4D and, 248
Ideas and, 235
InDesign and, 225–226
linking vs. embedding in, 222
making web page elements 

in, 230–231

non-Adobe programs and, 223
Painter, Go Media, Photoshop 

and, 250–251
PDF, Adobe Acrobat, and, 226
Photoshop and, 223–225, 237, 

240–241, 252–255
Illustrator Appearance Book 

(Miyamoto), 48
Image Trace

book illustrations with, 73
creating complex vector 

patterns with, 199
“Falling” graphic using, 216
guitar with photorealistic detail 

using, 139
Kuler and Live Color 

with, 134–135
overview of, 58–59
seed packet with, 72
self-portrait with, 75
Vintage effect with, 74

importing
Illustrator paths into 3D 

programs, 226
inDesign controlling 

for Illustrator 
files, 225–226

Kuler theme, 132–133
Photoshop Layer Comps, 224
Photoshop layers, 225

in port, Path type bracket, 
27, 28–29

InDesign, Adobe, 225–226, 233
Inner Glow effect, 18, 50, 165
interweaving objects, 213
Introductory sections, in book 

organization, xvii
Invert Mask, opacity masks, 185
iPad apps, 232, 235
Isolate Blending, Transparency 

panel, 187
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isolation mode
adding new members to Live 

Paint Group in, 57
creating opacity masks in, 185
editing clipping groups in, 190
editing envelopes in, 153
editing gradient meshes in, 141
entering and exiting, 6
overview of, 6
PEM as kind of, 180
protecting objects from Blob 

Brush in, 55
what you cannot do in 

PEM, 182
working with drawing modes 

in, 61

J
Jackmore, Lisa

Calligraphic and Bristle 
Brushes 
variations, 100

converting gradients to 
mesh, 140–141

creating artwork with 
symbols, 92

creating holes in objects with 
Eraser tool, 54

draw inside mode, 62
floral design using strokes, 98
illustration with Draw 

Inside/Bristle 
Brushes, 108–109

rotating objects in 3D, 157
using Image Trace, 59

Jackson, Lance, 215
Johnson, Rick, 236
Join style, Stroke panel, 86
joins, 60–61
Jolley, Donal

brushes and strokes 
sampler, 93

converting type to outlines, 31
Rubber Ducky using 

strokes, 97
text reflow, 26–27
width variations, 84
wrapping Area text around 

objects, 29
Joly, Annie Gusman, 

203, 204–205
Joly, Dave, 136–137, 248–249

K
Keep Selected, brushes, 90
kerning, warp typing using, 43
Keyboard shortcuts, xvi
Kimball, Mike, 24
King, Steve, 146
Klema, Stephen

constructing sculpture with 
Live Paint, 76

creating guides for arcs, 20–21
students of, 104–105
tool illustrations with Shape 

Builder, 77
Knockout Group, Transparency 

panel, 183, 187, 238–239
Kuler, 132–135
Kyoto Bus Station rendering, 218

L
labels, curve, 42–43, 44
Landscape orientation, 35–37
Larrett, Raymond, 36, 114–115
Lasso tool

creating blends along a 
path, 188

creating gradient meshes, 122
editing gradient meshes, 141
turning objects into compound 

path, 135
last used gradient ( “>” ), 123
layered patterns, 196–198
layers

adding at same level as path 
sublayer, 91–92

animation created from, 
228, 242–243

appearance attributes for 
entire, 19

controlling visibility of 
Illustrator file in 
inDesign with, 225

creating master layer, 192
exporting to Photoshop 

using, 238–239
Golden Gate Bridge 

anniversary poster, 24
masking images with, 208–209
naming, 6
navigating, 16–17
not duplicating or adding in 

PEM, 182
organizing complex objects 

with, 15
painting with Bristle Brushes 

in, 110–111
Pathfinder command applied 

to, 62
roping in paths using, 200–201
for scenes at different times of 

day, 163
for sets of guides, 5
working between Illustrator 

and Photoshop, 224–
225, 252–253

Layers panel
creating clipping masks in, 

189, 191–192
creating web page elements 

in, 230–231
decoding appearances in, 9
editing transparency, 186
and isolation, 6
navigating layers, 16–17
pasted objects retaining layer 

order in, 7
selection and target indicators 

in, 7
layout

Illustrator as stand-alone tool 
for, 36–37

pattern making, 182–183
LCD screen, 175
leaders, controlling in Tabs 

panel, 31
Leave Strokes, Option dialog, 90
Leavens, Chris, 80–81, 212–213
LeeDanielsArt, 247
legacy positioning, Global Rulers 

for, 4
legacy text, 33
Lens Flare tool, 202
letter spacing, 31, 43
Levy, Jean-Benoit, 49
lighting

adding to 3D Surface 
shading, 157–158

adding to mapped surface, 159
creating effects in 

Photoshop, 251
mapping artwork to 3D 

symbols and, 167
separating model from 

background, 165
line breaks, 31
line weights, 60, 115
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linear gradients
creating gradient meshes from, 

125, 140–141
creating with Gradient 

tool and Gradient 
Annotator, 147

drawing objects and filling 
with, 140

resetting to default, 122
switching between radial 

and, 122
using Envelope Distort 

with, 153
link icon, Transparency 

panel, 185
linked files, 222, 224–225
Links panel, linking files, 222
Liquify tools, 150
Live Color

adding and editing, 132–133
definition of, 125
editing brushes, patterns or 

gradients with, 126
Kuler and Image Trace used 

with, 134–135
overview of, 126
Recolor Artwork/EditColor 

dialog, 126–128
live effects

3D. See 3D effects
accessing from fx icon, 153
applying warps as, 152
creating interaction 

between character/
environment, 165

Live Paint
coloring line art, 66–67
constructing Paperzebra, 211
constructing sculpture, 76
hand-drawn look using Blob 

Brush and, 68–69
working with, 57–58

Live Paint Bucket tool, 67
Live Paint group

adding new members, 57
building complexity via, 14–15

Live Trace. See Image Trace
Locate Object icon, 4
lock/hide objects

from Blob Brush, 55
editing gradient meshes, 141
from Eraser tool, 54
using isolation mode instead 

of, 6
Lock/Unlock Guides toggle, 5, 20

logos
copying and duplicating with 

artboards, 39
creating complex clipping 

mask, 208–209
making symbols for replication 

and quick updates, 39
Stingray City, 50

Luminosity, Pit Bull poster, 52

M
Make Mask button, 212–213
Make/Release Clipping Mask 

icon, 191
management, of multiple 

artboards, 34–35
Map Art button, 158–

159, 167–168
mapping

adding shading and lighting 
to, 159

art onto object, 158–159
artwork to 3D symbols and 

lighting, 167
saving artwork as symbols 

for, 166–167
maps

adding and editing 
color, 132–133

labeling curving features, 44
setting type on terrain 

images, 45
Maric, Pete, 176–177, 250–251
markers, Recolor Artwork in Live 

Color, 128
Markiewicz, Danuta “Danka,” 73
Mask button, Control panel, 192
Mask View, opacity masks, 185
masks

clipping. See clipping masks
opacity, 184–186
working between Photoshop 

and Illustrator, 225
master layers for web 

pages, 16–17
McGarry, Aaron

gradient paths, 138
grouped blends, 188
inserting photographs in 

perspective, 174–175
realistic 3D modeling of, 

154, 156, 158, 
159, 166–168

simple to complex clipping 
masks, 208–209

urban portrait in Illustrator 
and Photoshop, 237

urban portrait using 
symbols, 116

MCKIBILLO (aka Josh McKible), 
96, 210

Measure tool, 11
measurement units, rulers, 4
Merge Live Paint button, 57
Merge Only with Selected, 55
merged objects, 55–56
mesh. See gradient mesh
mesh points, 124–126, 152
Mesh tool, 125, 141, 152
Metals library, 138, 168
Minus Front Pathfinder 

command, 65
Miter join, Stroke panel, 86
Miyamoto, Yukio, 48, 147
Miyamoto, Yukio and 

Nobuko, 117
mobile devices, Adobe Ideas 

touch app, 228, 235
modifier keys, drawing with 

geometric tools, 54
More Options button

Blend steps in 3D dialog, 155
lighting controls in 3D 

effects, 167
More Options dialog, 3D Surface 

shading, 157
motorcycles, PhotoRealistic 

techniques, 206–207
Move/Copy Artwork with 

Artboard icon, 11, 39
Murphy, John 

(photographer), 178
Murra (Mu!), Sebastian, 150
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N
Nahmani, Stephane, 7
naming

active artboard, 10
color groups and pattern 

swatches, 149
color groups in Recolor 

Artwork, 127
each artboard in set, 40
layers, 6
layers in Photoshop, 239
saving artboard stages for 

presentation, 78
single color in Swatches 

panel, 120
templates, 12
text, 30

NaniBird project, 210
NaniPeeps, 210
navigation, Artboard panel 

layers, 11
New Art Has Basic Appearance, 

9, 157
New Brush icon, 103, 117
New Color Group icon, 131, 

135, 148
New Document, 36–37
New Document Profiles, 4
New Graphic Style button, 9
New Layer icon, 6
New Light icon, 158
new paragraph (Return/Enter), 26
New Pattern brush, 117
New Swatch icon, Swatches 

panel, 120
New Window, 10
Nielsen, Chris, 206–207, 219
No Shading option, 3D Surface 

Shading, 157
non-Adobe programs, moving 

artwork in Illustrator 
to, 223

non-contiguous layers, 17
non-contiguous shift points, 85
non-rotated rectangle, converting 

to artboard, 11
Numbers

64-bit support, what’s new in 
CS6, xv

O
Object Layer Options dialog, 

InDesign, 225
object management, workspace

copy and paste techniques, 7–8
graphic styles and Appearance 

panel, 9
overview of, 5–6
Select Behind, 7
selection and target indicators 

in Layers panel, 7
using Appearance panel, 8–9
using isolation mode, 6

Object menu command, 189–191
objects

building appearance for 
single, 18–19

creating slices from, 231
disappearing from artboard 

when entering 
PEM, 181

making clipping masks 
from, 189

modifying before or after 
blend, 187

wrapping Area type around, 29
Offset Path, 125
one-point perspective view, 

163, 170
online resources, Help menu, xvi
online video game 

scenes, 164–165
opacity

brightening artwork with, 135
creating highlights using 

transparency, 202
reducing, 184
transparency referring to, 183

opacity masks
constraining texture using, 217
creating, 212–213
interweaving objects using 

complex, 213
overview of, 184–185
precisely targeting and editing 

transparency, 185–186
roping in paths using, 200–201
with shadows for soft 

transitions, 212–213
Opacity settings

adding transparency to 
individual mesh 

points, 143
 The Adobe Illustrator CS5 

WOW! Book 
cover, 215

assigning to gradient mesh, 125
basic appearance, 8, 18
Blob Brush tool, 55
California Magazine complex 

graphic, 214
creating dragonfly image, 101
creating glow, 205
creating transparency with 

blending modes 
and, 203

drawing complex elements, 173
Drawing Inside mode 

example, 81
drawing transparent 

brushstrokes, 102
drawing with appearances, 9
“Falling” complex graphic, 216
Frosty Cones example, 51
Golden Gate Bridge 

anniversary poster, 24
object transparency, 186
painting with Bristle Brushes, 

89–90, 110–111, 113
Transparency panel 

controls, 184
for type on terrain images, 45
Vintage effect with, 74

Options dialog, modifying 
existing brush strokes, 90

Orientation, Blend options, 188
out port, Path type bracket, 27–29
Outer Glow effect, 45, 165
Outline mode

isolation mode instead of, 6
paths shown in, 86

outlines
applying to stroke 

gradients, 124
converting type to, 30–31
creating background art and 

banners, 42–43
example of, 49
importing Illustrator paths into 

3D programs for, 226
painterly illustration with 

Bristle Brushes/Draw 
Inside, 108–109

Pit Bull poster example, 52
Overlap option, Art Brush, 88
Overlap option, Image Trace, 59
overrides, avoiding 

formatting, 29–30
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P
P. See Pen tool (P)
Paidrick, Ann

building gradient mesh objects, 
125, 129

creating pattern swatch 
combined with 
mesh, 144

distortion of envelope mesh 
object, 145

hand-drawn look of spirals 
using strokes, 99

transparent mesh for 
realism, 142–143

vector patterns, 199
paint bucket, using Shape Builder 

as, 57
Paintbrush tool

Blob Brush tool vs., 55
calligraphic attributes of, 54
customizing Calligraphic 

brush, 103
graphic illustrations of organic 

forms, 104–105
painting fur and folds of 

bulldog with, 113
setting preferences for all 

brushes, 89
painterly illustrations, 108–

109, 110–111
painting, with Blob Brush tool, 55
palette of colors, Image Trace 

panel, 59
panels, arranging in 

workspace, 2–3
finding, xvii

Papciak-Rose, Ellen, 184
Paperzebra, 211
Paragraph panel, 29
Paragraph Styles panel, 29–30
paste. See copy/paste
Paste dialog, creating Photoshop 

Smart Object, 224
Paste in Back, 7–8, 15, 61, 79
Paste in Front

building from simplicity to 
complexity with, 15

curving labels, 43
forming shadows, 201
ignoring drawing modes, 61
masking with multiple 

objects, 213
overview of, 7–8
reshaping with Shape 

Builder, 79

Paste in Place, 7–8
Paste on All Artboards, 7–8, 34
Paste Remembers Layer, 7, 209
Path Eraser tool, 54, 188
Path type

accessing Type Options dialog 
for, 33

applying to circle, 28
labeling curving features on 

maps, 44
manually flipping to other side 

of path, 28
overview of, 27
using Appearance panel with 

type objects, 32
working with threaded 

text, 28–29
Pathfinder

building image with basic 
objects, 13

combining paths with, 64–65
creating frame for portrait, 111
operating like compound 

shapes, 62
overview of, 63
PhotoRealistic complex 

graphics 
using, 206–207

roping in paths with, 200–201
simulating drapery folds, 144
textured graphics using, 217

paths. See also compound paths
altering/deleting with Live 

Paint Selection 
tool, 58

applying Path type to closed 
and open, 27–28

coloring line art, 66–67
combining with 

Pathfinder, 64–65
constructing shadows in 3D 

using, 167
creating blends along, 187–188
creating for envelopes, 153
gradient, 138
hiding/locking to protect from 

Eraser tool, 54
making ends meet, 86–87
modifying between existing 

width points, 84
modifying with Blob Brush 

tool, 56
moving artwork from 

Illustrator to 

Photoshop, 224
removing portion with Path 

Eraser tool, 55
roping in, 200–201
saving stroke profiles for 

other, 95
Simplify command for, 60
translating color into layers for 

filled, 218
Pattern Brush Options dialog, 

114–115, 117
Pattern Brushes, 88–89, 

114–115, 117
Pattern Editing Mode (PEM)

complex layered patterns 
in, 196–198

creating hand-drawn look for 
spiral patterns, 99

entering, 180–181
entering Recolor Artwork 

in, 148–149
expanded pattern objects 

and, 180
leaving, 182
recoloring patterns in, 183
what you cannot do in, 182

pattern fills, distorting using 
envelope, 153

pattern making
complex layered patterns in 

PEM, 196–198
complex vector patterns from 

photo, 199
creating intricate patterns, 165
creating pattern, 181–182
creating variation on 

pattern, 182–183
editing pattern swatches 

without PEM, 183
entering PEM, 180–181
layered patterns, 196–197
leaving PEM, 182
lesson in, 194–195
mastering, 180–183
NaniBird project, 210
navigating Pattern Options 

panel, 194–195
overview of, 180
recoloring patterns in 

PEM, 183
sample of unique patterns, 193

Pattern Options panel, 180–
181, 194–195
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pattern swatches
combining mesh with, 144
editing with Live Color, 126
editing without PEM, 183
exiting PEM without 

saving, 182
opening Pattern Options panel 

and entering PEM 
from, 181

recoloring, 148–149
rulers and, 4
vanishing artwork and, 181

pattern tile, 181–182, 196, 199
Pattern Tile tool, 181, 199
PDFs (Portable Document 

Formats)
exporting and printing 

artboards to, 35
moving artwork between 

Illustrator, Adobe 
Acrobat and, 226

opening other applications, 226
placing artwork from 

Illustrator into 
inDesign, 225

platforms saving files in, 223
recovering missing linked 

files, 222
using Create PDF Compatible 

File, 222
using EPS format vs., 223

PEM. See Pattern Editing Mode 
(PEM)

Pen tool (P)
building from simplicity to 

complexity, 14–15
creating cartoon character, 82
creating guides for arcs, 20–21
creating PhotoRealistic 

complex graphic, 
206–207, 218

drawing arch, 21
drawing new path, 13
drawing objects and filling with 

linear gradients, 140
“Good Food in the Microhood” 

illustrations, 107
illustrations of organic 

forms, 105
moving between Illustrator and 

Flash art, 246
for multiple construction 

modes, 80–81
tracing line art in preparation 

for Live Paint, 66–67
tracing template layer, 12–13

Pencil tool
creating icon with, 130
drawing Rubber Ducky, 97
illustration with Bristle 

Brushes/Draw 
Inside, 108–109

illustrations of organic 
forms, 105

labeling curves on maps, 44
making blends along path, 188
tracing template layer, 12–13

Perez, Richard, 217
“Permanent Pattern Panel,” 180
perspective

3D effect and, 154–159
architectural,  176,–

177, 250–251
CAD tools with, 236
changing in 3D 

effects, 155–156
guides, creating it with, 24
permanency of, 159

perspective grid, 
accessing controls for, 171
creating architectural 

renderings, 176–177
creating details with two-point 

perspective, 173
limits of, 161
overview of, 159–161
simulating one-point 

perspective 
view, 170–171

toggling, 159
Perspective Grid tool

for architectural 
renderings, 176–178

overview of, 159–161
simulating one-point 

perspective view, 171
Perspective Selection tool

adding buttons to perspective 
grid, 175

attaching complex elements to 
Perspective Grid, 173

creating architectural 
rendering from 
photo, 178

overview of, 159–161
Photoshop

California Magazine graphic 
using, 214

creating 3D version of 2D 
object in, 164

exporting to, 183, 238–239
“Good Food in the Microhood” 

illustrations, 106–107
Illustrator and, 223–225, 237, 

240–241, 252–255
Illustrator, Cadtools, and, 236
Illustrator, Painter, Go Media 

and, 250–251
importing Layer Comps, 224
painterly portrait 

with, 110–111
pasting compound shapes as 

editable layers in, 63
placing web slices, 224

picas, 22–23, 36–37
Pick Color From Artwork, 79
Pit Bull poster example, 52
Pixel Preview, 226–227, 230
pixels, from Illustrator to 

Photoshop, 224
Place Symbol icon, 90
plane, Perspective Grid, 159–161
Plane Switching Widget, 

Perspective Grid, 160–
161, 171, 177

“Planning Ahead” 
lesson, 153–154

Plastic Shading, 3D Surface 
Shading, 157

POD (Print on Demand), 36
point map technique, 187
Point type, 26, 32
points, auto-scaling 

artwork, 22–23
Polygon tool, 13, 217
portrait orientation, printing 

artboards, 35
portraits

customized Calligraphic brush 
for, 112

painting with Bristle 
Brushes, 110–111

“Ports defined” Tip, 29
posterize, using Image Trace, 134
preferences

Auto Collapse Icon Panels, 3
for brushes at application-

level, 89
Constrain Angle, 5
measurement units, 4
Smart Guides, 5

Premedia Systems WOW! 
Artboard 
Resizer, 140–141
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Premedia Systems WOW! 
Colorizer script

adding and editing 
colors, 132–133

reshaping with Shape 
Builder, 78–79

pressure sensitivity, Eraser 
tool, 69

Preview mode, paths shown in, 86
Preview, toggling in Image 

Trace, 58
Print dialog, designing to edge, 10
Print on Demand (POD), 36
Print to PDF dialog, 35
printing

Bristle Brush strokes and, 89
multiple artboards, 35
spot colors used in, 121
templates using Tile option, 21

process colors, 120–121
profiles, Width tool and 

stroke, 84–85
Projecting cap, Strokes panel, 86
properties

single brush stroke, 90
Symbolism tools, 92

Pucker tool, 125
Putnam, Ryan

adding arc effect to 
headline, 46–47

combining paths with 
Pathfinder, 64–65

creating identity with multiple 
elements, 38–39

custom coloring, 130–131
Frosty Cones example, 32, 51
from sketch, to Blob Brush, 

and Live Paint, 68–69
stroke variance, 94–95

Puzzled Squirrel Press, 36

R
radial gradients

creating glow from, 204
creating with Gradient 

tool/Gradient 
Annotator, 147

overview of, 122–123
Range setting, printing 

artboards, 35
raster images

converting to vectors with 
Image Trace, 58–59

mapping gradients saved as 
symbols with, 158

moving artwork from 
Illustrator to non-
Adobe programs, 223

placing in book layout, 37
for web page elements in 

Illustrator, 230–231
Rearrange artboards, 10, 34
“Ready to Export” 

lesson, 238–239
Recolor Artwork/EditColor 

dialog, Live Color
editing pattern swatches, 148–

149, 183
overview of, 126–128
recoloring patterns in 

PEM, 183
recoloring traced artworks, 

133, 135
“Recoloring a Patter” lesson, 183
Rectangle tool

creating gradient meshes 
with, 142–143

creating icon with, 130
creating rectangles for columns 

of text, 37
creating textured graphic, 217
drawing arch, 21

rectangles
abstract, edgy smartphone 

case, 150
combining paths with 

Pathfinder, 64–65
converting to artboard, 11, 35
creating gradient meshes 

with, 142–143
filled with blend modes to 

change time of 
day, 162–163

reference point, artboard, 11
References, in book organization, 

xviii

Reflect tool, 20–21, 166
reflections, adding to windows in 

Photoshop, 251
Registration point, symbols, 91
registration rectangle, 

Photoshop, 253
Reinhart, Sabine, 148–149, 196–

197, 198
renumbering artboards, 34
reordering artboards, 10–11
Reset icon, default width 

profiles, 84–85
reshaping dimensions

3D effects. See 3D effects
envelopes, 153–154
gallery examples of, 164–165, 

168–169, 178
overview of, 152
Perspective Grid, 159–161
warps, 152–153

reshaping dimensions, lessons
one-point perspective 

view, 170–171
perspective in architectural 

sketch, 176–177
photographs inserted in 

perspective, 174–175
realistic 3D modeling, 166–167
two-point perspective 

view, 172–173
warp and distort, 162–163

Return/Enter (new paragraph), 26
Reverse Front to Back, 

blends, 188
Reverse Spine, blends, 188
Revolve Options dialog, 3D 

effects, 156–159
Riddle, Mic, 248, 249
Roberts, Andrew, 229
Roorda, Jolynne, 230–231
roping in paths, 200–201
Rotate Options dialog, 3D 

effects, 155–157
rotation, of gradients, 124
Roughen effect, 162–163
Round cap, Strokes panel, 86
Round join, Strokes panel, 86
Rounded Rectangle tool, 64–65
Roundness, customizing 

Calligraphic brush, 103
Rubber Ducky, 97
Rudman, Andrew, 14–15
rulers, 4, 20, 37
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S
sampling text, Eyedropper 

tool, 31
San Francisco Embarcadero 

waterfront, 217
Save A Copy, PEM isolation 

bar, 183
Save for Web, 226, 231
Save Grid as Preset, Perspective 

Grid, 177
saving

artboards as PDFs, 35
artboards as separate files, 35
color groups and pattern 

swatches, 149
with Create PDF Compatible 

File, 222
current appearance, 9
custom stroke profile, 85
custom swatches as new color 

group, 131
custom workspace, 3
customized grid in Perspective 

Grid, 160
layered Illustrator files as 

layered Acrobat 
files, 226

map artwork as image and 
slices, 231

New Document Profile to 
Library presets, 4

program files as PDFs, 223
stroke profiles and applying to 

other paths, 95
swatch library, 131
width profiles, 98

Scale Strokes & Effects, Scale 
tool, 60

Scale to Fit button, 3D 
effects, 158–159

Scale tool, 27, 60
scaling

altering stroke weight and, 60
applying 9-slice scaling to 

symbols, 91
Area and Point type, 26
auto-scaling art, 22–23
gradients, 124
mapping symbols onto 3D 

object with, 158
text frames only, 27

scanned images, tracing template 
layers with, 12–13

Scatter Brushes
gallery examples of, 118, 216
working with, 88–90

Scissors tool
creating Rubber Ducky, 97
cutting ellipse for curved 

banner path, 42
drawing arch, 21
drawing tube, 201

scripts
adding and editing colors 

with, 132–133
Premedia Systems WOW! 

Artboard Resizer, 79
Premedia Systems WOW! 

Colorizer, 78
sculpture, using Live Paint on, 75
Select All, 148–149
Select All Unused, Swatches 

panel, 120
Select Behind cursor, 7
selection indicators, Layers 

panel, 7
Selection tool, 13, 26
Sellers, Rachel, 12–13
shading

adding to mapped surface, 159
adding with Drawing Inside 

and Blob Brush, 81
surface, applying to 3D 

objects, 157
shadows

constructing in 3D, 167
creating soft transitions 

using opacity masks 
with, 212–213

gallery examples of, 101, 
168, 203

painting in layers with Bristle 
Brushes, 111

Shape Builder tool (Shift-M)
building image with basic 

objects, 13
building with multiple 

construction modes 
using, 80–81

constructing objects 
with, 56–57

gallery examples of, 77, 82
rapid reshaping with, 78–79

Shape Modes, compound 
shapes, 63

shapes. See compound shapes
sharing artboards and 

libraries, 39

Shift-B. See Blob Brush tool 
(Shift-B)

Shift-D (toggling drawing 
modes), 61

Shift-M. See Shape Builder tool 
(Shift-M)

Shift-O. See Artboard tool 
(Shift-O)

Shift-W. See Width tool (Shift-W)
Shortcuts, xvi
Show Gradient Annotator, 124
Show/Hide Thumbnail, 9
Show Options, Transparency 

panel, 187
Show Transparency Grid, 

Document Setup, 183
Simplify command, 60
Simulate Colored Paper, 

Document Setup dialog, 
40, 183

Single-line Composer, 31
size

Color Guide panel, 122
complex layered patterns in 

PEM, 196
customizing Calligraphic 

brush, 103
panel, 3
printing artboards larger than 

your media, 35
Sky gradient, 175
slices, 231
Smart Filters, exporting layers to 

Photoshop, 239
Smart Guides

coloring line art, 66–67
creating and managing 

artboards 
manually, 10

creating guides for arcs, 21
Illustrator, Cadtools, and 

Photoshop art, 236
organizing your workflow, 4
rapid reshaping with Shape 

Builder, 78
toggling for warps and 

envelopes, 153
Smart Objects, 63, 223–224, 239
smartphone case 

example, 142–143
Smooth Color, Blend options, 187
Smooth tool, 188
Smoothness control, Pencil 

tool, 13
Smoothness settings, Options, 

81, 104–105
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Snap to Point, 54
solid color types, 120–121
spacing, between dashes, 86–87
special characters, in Glyphs 

panel, 33
Specified Distance, Blend 

options, 187
Specified Steps, Blend 

options, 187
spine, of blend, 188
Spiral tool, 99
Split Into Grid command, 

printing larger 
artboards, 35

spot colors, 121, 128, 157
stacking order

attribute appearance and, 9
masking surfboard image, 208
panels, 3

Star tool, triangles, 13
Step-by-step lessons, in book 

organization, xviii
Steuer, Sharon, (this book), 

78–79, 102–103, 106–
107, 233

Stikalicious™ characters, 40–
41, 232

Stingray City excursion, 50
Stoppee, Janet, 72
straight lines, tracing and 

adjusting, 12–13
Stretch Between Guides option, 

Art brush, 88
stroke gradients, 122–124
Stroke Panel, Width Profiles, 96
stroke profiles, 95, 115
stroke weights, 60, 114
strokes

adding to clipping group/
mask, 190–191

adding to type objects, 32–
33, 45

applying gradients to, 84, 124
brushes and, 87–90
coloring line art, 67
creating paths using, 138
deleting with Shape 

Builder, 56–57
duplicating, 9
modifying appearance of Shape 

Builder, 57
overview of, 80
painting with Blob Brush 

tool, 55–56

retaining interior, 56
saving current color as 

swatch, 120
Strokes panel, 85–87
viewing/editing in Appearance 

panel, 9–10
Width tool and stroke 

profiles, 84–85
working with symbols, 90–92

strokes, gallery
brushes and strokes 

sampler, 93
California Magazine complex 

graphic, 214
Calligraphic and Bristle Brush 

variations, 100
floral design, 98
“Good Food in the Microhood” 

illustrations, 106–107
guitar with photorealistic 

detail, 139
hand-drawn styles, 96, 99
illustrations of organic 

forms, 104–105
intricate beaded necklaces, 117
painting fur/folds with Bristle 

Brushes, 113
realistic modeling of firefly, 101
realistic modeling using Art/

Scatter Brushes, 118
Rubber Ducky, 97
self-portrait with Calligraphic 

Brush, 112
Stingray City logo, 50
urban portrait using 

symbols, 116
strokes, lessons

characters built with pattern 
brushes, 114–115

drawing with naturalistic 
pen, ink and 
wash, 102–103

illustration with Draw 
Inside/Bristle 
Brushes, 108–109

painting in layers with Bristle 
Brushes, 110–111

stroke variance, 94–95
Strokes panel, 84–87
sublayers

adding to symbol’s artwork, 91
creating, 16–17
exporting to Photoshop 

and, 183
not duplicating or adding in 

PEM, 182

SuperGraphics, 146
Surface shading, 3D objects, 157
surfboard design, 208–209
Sutherland, Brenda, 158
Swatch Bounds

creating complex layered 
patterns in 
PEM, 195–197

creating patterns in 
PEM, 181–182

Tile Bounds vs., 182
vanishing artwork in PEM 

and, 181
Swatch groups

creating in Live Paint, 67
recoloring shapes with 

custom, 76
saving in Color Guide 

panel, 122
specifying color mode in Image 

Trace panel, 59
working with WOW! Artwork 

Colorizer, 78–79
swatch library

choosing gradient style 
from, 122

choosing process colors 
from, 120

choosing spot colors from, 121
in Image Trace panel, 59
limiting colors in Recolor 

Artwork to, 128
saving, 131

Swatches panel
adding Kuler theme 

to, 133–135
color groups and, 121–122
dragging pattern tile to, 180
entering PEM from, 181
saving layered pattern in PEM 

to, 197
working with, 120–122
working with gradients in, 

122–123, 137
SWF frames, 228
Symbol Libraries, 91, 116
symbol sets, 92
Symbol Sprayer tool, 92, 116
symbols

9-slice scaling on, 228
animation of, 227, 244–245
attaching to perspective 

grid, 159–161
duplicating elements to 

multiple artboards 
using, 34
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editing with Live Color, 126
gallery example with heavy use 

of, 116
mapping onto 3D objects, 

155, 158–159
placing artwork from 

Illustrator into Flash 
using, 227–228

replication/quick updates 
with, 39

saving artwork for maps as, 166
Scatter Brushes vs., 90
turning artwork on artboard 

into, 11
working with, 90–92

Symbols panel, 90–92

T
tabbed documents, 2
Tabs panel, 31
Taj Mahal building 

perspective, 169
Tan, Moses, 118, 218
target indicators, Layers panel, 7, 

19, 22–23
templates

accessing, xvi
in Cool Extras folder, 4
drawing with Pencil tool, 211
inserting art into, 210
placing artwork as, 102
placing sketch, 68, 94–95
printing, 21
scanning sketches as, 200
tracing, 12–13
using for artboards, 40–41
using photo as, 52

terrain images, setting type on, 45
text. See also type and layout 

design
attaching to perspective 

grid, 159–161
formatting, 29–30
moving between Illustrator and 

Photoshop, 224
pasting into inDesign, 225
wrapping Area type around 

objects, 29
Text tool, 43
texture, vector images, 217
threaded text, 28–29
three-point perspective view, 163
thumbnails, 9

Tiling tool, 21, 35
tints

Color Reduction Options 
for, 128

gallery example using, 75
for layers showing different 

times of day, 163
viewing colors as, 122

Tips, in book organization, xvii–
xviii

titles
arcing type for, 46–47
creating depth for, 52
creating with Type tool, 37
Pit Bull poster, 52

Tom, Jack, 42–43
Tools panel, 79, 123–124
tracking, warp type, 43
Transform effect

auto-scaling artwork, 22–23
copying art between 

artboards, 11
copying instances of artwork to 

another artboard, 34
gallery example using, 50
pasting Smart Objects from 

Illustrator into 
Photoshop for, 239

transitions
color, color transitions
masking with shadows for 

soft, 212–213
transparency

applying to gradient mesh, 
125, 142–143

brushstrokes for, 102–103
creating highlights and glows 

using, 204–205
creating highlights using, 202
creating with opacity and 

blending modes, 135, 
184, 203

dragonfly image showing, 101
Flash retaining, 228
gallery example using, 214
locking to limit tool/command 

to just pixels, 252–253
opacity masks and, 184–186
overview of, 183
SuperGraphics with gradients 

showing, 146
Transparency panel, 185–187
Trash icon, deleting colors, 120
Tremblay, Jean-Claude, 153
triangle, creating, 13
“Trick or Treat” movie, 248, 249

Turton, David, 70
two-point perspective view, 163, 

169, 172, 174–175
type and layout design

advanced features of multiple 
artboards, 33–35

converting type to 
outlines, 30–31

formatting text, 29–30
Glyphs panel, 33
types of type, 26–28
using Appearance panel with 

type, 32–33
using Eyedropper with type, 31
using type as clipping 

mask, 192
working with legacy text, 33
working with threaded 

text, 28–29
wrapping Area type around 

objects, 29
type and layout design, gallery

examples of complex 
type, 48–52

labeling bold terrain image on 
map, 45

labeling curving features on 
maps, 44

type and layout design, lesson
arcing type with warps and 

envelopes, 46–47
creating identity with multiple 

elements, 38–39
graphic novel cover 

design, 36–37
streamlining file output with 

artboards, 40–41
type on curve and warping 

type, 42–43
Type characters, 32
Type objects, 32, 62
Type on a Path, 33, 43
Type Options dialog, 33
Type tool, 26, 32–33, 37, 49
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U
“Using the Appearance Panel” 

section, 8
“Using Isolation Mode,” 6
Undo, Pathfinder operations, 62
unified gradients, 136–137
Unite Pathfinder 

command, 64–65
updates, 33, 39
Untapped Cities 

illustrations, 106–107
User Defined library, 116, 131

V
vanishing points, perspective 

grid, 159–161, 
171, 173–174

variation, pattern, 182
vector artwork

applying texture, 217
attaching to perspective 

grid, 159–161
book layout with, 37
converting from rasters with 

Image Trace, 58–59
from Illustrator into Flash, 227
from Illustrator to non-Adobe 

programs, 223
galleries converting from 

rasters with Image 
Trace, 72, 73, 74, 75

VectorScribe, 234
Vektorgarten site, 211
visibility

of attributes and thumbnails, 9
controlling how Illustrator 

file imports top-level 
layers, 226

of guides, 5
of layers in InDesign, 225
of layers in Photoshop, 214
of layers to organize complex 

objects, 15, 17, 50
of template layer, 102

W
Wacom tablet, 87–88
warps

applied to type, 30–31, 42–
43, 46–47

applying and editing, 152–153
creating headline text, 69
envelope, 154
modifying gradient mesh 

shapes, 125
wash strokes, 103
web graphics, 226–227, 230–231
web slices, Photoshop, 224
Welcome Screen, xvi
Western Bullets WF, dingbat 

font, 52
white snap-to cursor, 54
Wide Fan Brush, 111
width points, Width tool, 84–85, 

90, 94–95
width profiles, 84–86, 98
Width tool (Shift-W)

adjusting pattern brush fit, 114
gallery examples of, 96–99
modifying Art Brush with, 

70, 88
stroke variance with, 84–

85, 94–95
transforming brush strokes 

with, 93
Wigham, Laurie, 22–23, 233, 246
“Wind,” 255
Winder, Darren, 139
word spacing, 31, 43
workspace

gallery example, 24
managing multiple 

artboards, 9–11
object management, 5–9
organizing custom, 2
organizing New Document 

Profiles, 4
organizing rulers, guides, 

Smart Guides and 
grids, 4–5

saving Pattern Options panel 
in custom, 180

workspace, lessons
auto-scaling art, 22–24
basic appearances, 18–19
guides for arcs, 20–21
navigating layers, 16–17
starting simple for creative 

composition, 14–15
tracing template, 12–13

WOW! Artwork Colorizer, 78–79
WOW! Books, epub versions, xv
WOW! ONLINE

accessing artwork from, xvi
downloading electronic version 

of book, xiv–xv
wrapping Area type, 29

X
X axis, 3D effects, 155–157

Y
Y axis, 3D effects, 155–157
Yap, Brian, 228, 235

Z
Z axis, 3D effects, 155–157
Zen of the Pen courses, xv
Zig Zag effect, 163
zoom, 11, 13, 206
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